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Agenda

= Contest Rundown
= Overview of the contest iechnical scope

» Description on the contest PG setup and contest
workflow

= Overview of the contest guestions
= How to answer the questions‘

T et =3
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Contest Rundown

Date:  Jan 29, 2011 (Saturday)

Time:  2:00 p.m, - 5:30 p.m.
{registration staris at 1:30 p.m.}

Venua: Cilitons Centrat Tralning Cenire, Level 33, 8 Queen's
Road Central, Hong Kong -
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Contest Rundown

1:30- 2:00pm

Registration

2:00-2:15pm

Welcome Speech

2:15 — 4:15pm

Compelition takes place

4:15 ~ 4:45pm Marking
4:45 — 5:30pm Award Presentation
PR e freven 62011 B Corportson

. |BMHKSoware Group

Prize

Champlons =HK$30,000' Cash Award
»Champlon Trophy -
»Three-month Summer Internship
Program at 1IBMe

First runner ups =HK$15,000f Cash Award
=154 runner up Trophy

Second runnsr ups =HK$ 9,000 Cash Award
=2nd runner up Trophy

All Contestants =}BM Trendy Backpack
*IBM Participation Certiflcate

Thie Champlon Unlversity* } *Champlon Trophy
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Contesi Rules (1)

= Thecontest has a duration of 2 hours.

«  One PC and one terminal wilk be provided for each team.

- gﬂsue’_ls?f fuestions will be given fo eachteam lo bé completed within 2

= The contestis an open book contest, Contestants could bring In their
reference books for the contest.

= internet Access NOT allowed.

»  Inter-Team Communication ROT allowed,

= QNLY Intra-Team Communication allowed.

«  Allthe questions and relaled schema are provided 10 the students atthe
beginning of the contest. Questlon sheetis plovided in hardeopy formu

= Onceateam compleles a question, the result s submitted 1o the judge. A
time Is recorded as the submission time, Than ihe judpe wilt svaluate the
submitted answer, It case the validation fails, the tearn will be notified
2nd feedback will be provided to the team.

sz 201 BM Carporzlion.
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Contest Rules (2)

« Eachleam can have THREE chances 1o submit the answer of eath
quastion: {For progtamming quesitons only}

- Eszchtime thae leam submits an answer, tha 1ecords the submission tme and
funs b $5ored procedure to r.hackmeansmé?dng‘ie answer 1 coreect, they wilbe
anaded for the question. H the answer ls ncozrect, the contest syslem wit
‘send 1he answer back 10 1he leam and The1easm ¢an then re-submi agsin up o

- Full pants will b provided If the answer is cofrecl
. Partlal poiis might be given on programining questions.
+ For each quéestion, he Tighest paind cbigkned whl be recarded 25 24 foal poira.

Adter the eontest Is over, the feamwhich gets the mast polnts wing. i
several teams get the same number of pelats, the one withibe earllest last
submission time wins.

The decisions of the Judges will be fipal. .

£33 reserves the Hght to publish tha photographs andlor names of all of
anrynprizewmlru-harsﬂltg\anyg)!"'i?sr P’M?g Phes sndfor advedti it
as it sees i,
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Technical Scope

-

= Qverview on |1BM middleware

platform. For example:
— How 1o submit DDL and DML commands
~ How 1o interpret error messages
—How to save resulis
» Overview on graphical interfaces

YebSphere Portal Server
= Overview on Tivoll Netcoo! Omnibus

==y

L85

= DB2 basic operations on distributed ptatform and mainframe

* Overview on web programming using Java, DB2, WebSphere
Application Server, Rational Application Developer and

L] B o amiirg Corfad vantE
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Teamn Scoreboard (will be refrashed avery 15 mins)
Contest PC Selup 20 e
e
» Networked student PC and Instructor PC % ::
« CPU : Inte! Core 2 Quad Q9400 2.66GHz 2 —
» Ram : 4GB (2GB effective in ViMware) 17 i?
= Hard disk : 500GB HD 13
» One set of keyboard, mouse and a 17” TFT fiat s =
screen 5
1 ':'E==
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Announcement

= Announcement will be published to the projector
and by voice.

l Information Management

Questlon Overview
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Two Typeg of Questions Distribution of Points
Drsiion Number | Dificalty {* {0 7%} Folaf
« Section 1 Multiple Choices S T 55
~Cholces of A, B, Cand b E s 1
- Can only submit all the answers ONCE - x
. . P
« Section 2 : Programming Questions : — o d\(\\‘é ;‘3
~ Nead to perform programming work - mla 16 mp\e 12:;
T H
— Provida URL as the answer i.';{\sa i) B
- Judge witl check the correciness of the answer by 3 i ls;
runping your program ¥ o o
— Gan submit answers up to three times o ST 2
Section 3 Tota) 858
Grapt Fotal 1000

B Progranting Conlin 1A

- © &4 B Corperation.

1

2]

M Progranmig Corfest

1zt

©2511 = Carpenrion




} EBM HX Softsars Growp.

Using Samenme to Submit Answers )
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Using Sametime to Subrnit Answers (2)
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Using Sametime fo Submit Answers (3)
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Using Sametime to Submit Answers {4)
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Using Samelime 1o Submil Answers (5)
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Using Sametime to Submit Answers {6)
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Agenda

* 9:16am « 10:30am: Introduction, contest anvirenment
walkthrough and DB2 with LAB

= 10:30am - 14:30am: Tivoli with LAB

= f1:30am - 12:30pm: WAS with LAB

= §2:30pm - 1:30pm: Lunch

= 1:30pm - 2;30pm: Portal with LAB

» 2:30pm - 3: 30pm: Mainframe with LAB
= 3:30pm - 4:30pm: RAD with LAB

» 4:30pm - 5:30pm: Cognos with LAB

2011
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Contest PC Environment

* You have a chance to walk through the PC
environment by running the lab today

Ready to Go?
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IBM Inter-University
Programming Contest 2011 Training

Chapter 1b: DB2 Operation Overview

Software Group, IBM
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Chapter Outline
= Tools to Access DB2
= PB2 Instances and Databases
= Bufferpoot
« Tablespaca
= Schema
» Data Type
= Table
= Inserd Slatement
» Update Statement
= Dekete Slatement

I avrysh s = Salkect Statement

e [ )

[, T * Select Statement Options

[ -« Bl 1572011 © 2008 1204 Corpor aficn. _ [ P —_— R
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Command Line Access

+ DB2 CommandLine Processer (CLP)
- cﬁckmeBzcommunePtocassorbmweﬁammammandwm
~ anieiactive nput prompl appRars:
. gh2=>
~ 10 hetd 40 prefi commands wih 'dbZ
v @0 dhZ => connecl 10 sampla
— o end tha Interaclive mod, enter quit
- {g_ﬁ:ggﬁdkm"wdalabas&andlm!amb& backend protess {do2bp), enter
~ foexesute OF cominands, entes 105 tommand>
» DB2 Command Eine Window
- eﬁckmmamcanmandwmowbmuﬂanus-wsyomm.wammﬂ
+ Th command db2omd I vaiid Foe Wirdows only
~ irrenka thie Inerpreler by prefacing commands and SOL with ‘b2’
+ eg Gb2connett to sampla
« pg do2 bselect * from employee®
v gg db2 -4 createtab.do
- mﬁnmmmw:mlemnmmwm(m).wam
— aFf O commands £an be issued from B DB2 Commard Window

4 { DR2 v S Traing w01 99 (M -blarch-2008) Ve 2008 (B8 Carpors'icn




r(teé\q

/‘< {o

[ Information Management

Getting Help

= Obtain syntax ang Information for DB2 commands from the command

line

— b2 7" list of all DB2 commands .

- db2 *7 <gb2-gommand>" gel synlax help lor a spesific comman

— db2 “? sqinphn, * get message and brief descriplion of a
specific SQLCODE

— ¢b2 "7 db2nnon” get message and brisf description of a DB2 error
coda

= For example:
~gb2 "7 cataleg tepip”

CATALOG [ADMIN] TCPIP NODE node-nama REMOTE hosiname
{SERVER sendcsname] [SECURITY [SOCKSH
[REMOTE_INSTANCE Instance-name}HSYSTEM system-name}
[CSTYPE os-typa} [WiTH "comment sting™]

Command Line Optlons

= To st default command pptions
— LiST COMMAND OPTIOHS -
re o poreler te @acoc te bt
borpess e el tTee fawaraded
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-u  Dlaplay FETCRIFELICT wblig 2oamiges -
- Fperers prlalng 6 colow bendltae L33 . ‘\
2 hewo a1l T le smrps (D0 L5 A4 {
* Tochange default command oplions, T .
- Fof examph, 10 Jam aus i off: so) t

+ Yo changa command opon for ihe curcent session
~ Foreommph, 10 52v8 0Lt 10 flec UPDATE COMMAND OFTIONS USING 2 ON oiiputtxt
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PB2 Instances and Databases DB2 Instances
» ADB2 instanca ks a fogical context In which DB2 commands and functions are
executed
» Aninslance manages access o database files
« More than one Instance can bs defined on a server mackhine
* Each Instance I indepondent of the others
= Aninstance Is eresled on instal by defaut
~ db2instl (UNDO
~ DB2 (Windows)
+ Toslarian h‘sta/
B :
= Siytfa ;prﬁota Instance
dbastart HEMD/'I’,EE&W rame»
" Starfthe Instapch i quiesced mode foc admintstralion purposes
dbostart AMA MODE
o Terminaté all datsbése connecions and stop antnstance
- dh2stop force i
[ L] i 0229 5 Trating VS50 (Lb-Adorch 2006} —_ AN © 2008 1254 Corponation. _lﬂlhi._' DB v3 5 Traiing v 59 [H-LLach 2008 Rt el & 2008 134 Corpereion
-~
Finfompaton Managemant . - R R —— ig8ny
Managing DB2 Instances Create a Database
+ o create addional netancss ‘ » Simplest format
~ db2ert-u <lenced user [D>"cinstance name> -
+ s specity fenced Yt 1D tor UNIX plations CREATE DATABASE dalabase-name
= HhRicrt <nstanch me> - g
+ forWindows pitiomns e = Mate options:
* Terminate g/l datlabase nonmcbom drop an knstance
— dbZidpp <t <instanca name= o CREATE DATABASE dalabase-nama
- Tolis) ésting instances defined i@ sorver - FAUTOMATIC STORAGE {NC | YES})
- gcmém “s/ L ] [ON debvel{ciive) . XDBPATH ON divel}
DR2 Fiétance for ascess fodl sociated with Insiataon o [ALIAS datsbase-alias]
R i product o e e od il Instafaton o JUSING CODESET codesel TERRITORY tenftory]
- dueue grmcenanes o E?fxsg; AR EARRGE thispace-defn)
» Tomigrated an existing inslancé, for UNIX platiorms onfy / [USER TABLESPACE bispaca-eln)
— Gb2pilgr <istance pame> "\Q-, T}, L . Va [TEMPORARY TABLESPACE thispace-dofn} ‘
* TFo _q‘éie, drop, update, é migrate %s 3 /vooi or administrative access is [AUTOCONFIGURE [USING config-keyword value [[.config-keywerd value). ]}
.rggwed P /
P / ) J
/ k
e e e e —
1 T mﬁsnmms&umm /’ A © 2008 50 Corparafion. 2 2 vE:§ Tl v 56 [14-0ach 2008} LE-ru ) 10 2008 K Garporation.
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Database Object Hlerarchy
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Bufferpooi ) /‘

= Used to buffer data i memory io reduce 1he number of

1/O operations t?h physical database/
= Keep often reqlested data/i nde); pages in memory

= Keep infreq/uently accessed }abtes {e.g. random access
Info \fgnf large table} out of fnain memory

» Most data manipulation’ !akes place In buffer poois
except for large objects and long field data

-
» IBMDEFAULTBR s the default buﬁerpool ‘created with

-

-

Mematy fof the bulfer pool ks aliocalad when the dal abass i3 activaied or when the first
application connects to the dalabase

Command to creale butfer poot

GCREATE BUFFERPOOL bprams IMMEDIATE SU2E 52 PAGESIZE o
CREATE BUFFERPOOL bornsme DEFERRED SIZE s PAGESIZE pgst

IMMEDIATE

- Bufferpoot be created immediatety

DEFESRED

~ Bufferpool be created when the dafabase ks reacvated
Information stored in SYSIBM.SYSBUFFERPOOLS

Aller size of a budferpod
ALTER BUFFERPOGL bpname DIMEDIATE SE a2
ALTER BUFFERPDOL bprame DEFERRED SIZE &2

Mamory Is altocated es soon as i the memoy is avelable.
1§ the memory is not avaltable, the changad ocours when the dalabass bs 1eactivated
it tha size of the buferpoot is decreased, memory is dealioraled at commit fme

[ 032 v § Training 0T (14-4arch-2008) E05) © X3 F Copantion
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Bufferpool Management Tablaspaces

Table space ks a kogical grouping of tabled and other objecls in a database
A gatabase oblects are stored within akie spaces

T types of storage

- System Managed Space (SMS)

.. palabase Mansged Space DMS)

Alatle spaceis compossd of one of more containers

Dala aliocated by exdents within confainers

Table spaces ara elther 4K, 8K, 15K or 32K pages

~ 4K s defaitt size

- Must beassochled witha hw!erpootwihsmepageéza

bEZ:Q.S'l:H‘\gVJBJII ¥ 1

18 2008 7241 Corpertion:
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Defauit Tablespaces in a Database

« With a simple CREATE DATABASE command:
~ CREATE DATABASE sample
« Thres SMS lable spaces are crealed attomatically in default locaBons:
— SYSCATSPAGE - system catalog lables
- USERBPACET - default user data
— TEMPSPAGE! - iempomry data
» Canchange tabla space storage typs and explicitly specily the focations of tha
containers: .
CREATE DATABASE £ -y

G\ume{gms ACE .
MANAGED BY.SYSTEN
USING { thcaldri

Wi detoba ¢ yieng

RN
oA

_ ... | Irromation Management

Schema

= Aschema is a cofiection of dalabasa objects such as tables, views, Indexes,
or iriggers. H provides a logleal classification of database objects

» How Is a Schema name used?
~ Fully-gualified object name: *schemaname.iablename®
- Gan have multiple tables with the same nama, but ditferent schema names
« eyermanstalf 1= jones.stalf
» Resenved schema names
~ SYSCAT, SYSIBM, SYSSTAT, SYSFUN
— Avoid schema names begioning with SYS
= |l database object does not speciy a schema name, table qualified with

USER TABLESPACE Byt gty ! current authorization ID
MANAGEDBY TRTADASE . P . .
DSING ( FILE ‘cAdbaitesumsenbsp] 100, FILE ‘tdo2Tesusenbsp? 100} » Allesnale schema names can be specified using
TEWP TABLESPACE - SET CURAENT SCHEMA or SET CURRENT SQLID command
MANAGED BY SYSTEM N N .
USING { ‘cirempspace’) ; IR “("\ ~ CREATE ALIAS <aliasname> FOR <lab/view name>
TR — CREATE VIEW
T v sz ey T e ten st Gaoton ol R = 2008 B Drepernion
| ndarnation Management - . __ | o b L
System Schemas System Catalog Tables and Views
i View = SYSCAT
» Created with every database and placed into the SYSCATSPACE e
table space :
+ SYSIEM
— Basa catalegs
- Access not recommended
= SYSCAT
— SELECT authority GRANTed to PUBLIC [SYSREYCOLUSE =]
- Catalog Read-only Views AEAEESDIRLAGESL,
. |SYSDATATYRES =1
~ Recommended way to obizln calalog information SYSEVENT
* SYSSTAT , REEEE s e
- Updateable Catalog Views - Influence the Optimizer R
' SYSFUN ~' &
- User-Defined Functions VSO CAUTIEET
1w ' D2 vaLS Trabdng vOED (T4-Kleret 2008 hErul 182000 B Corporatiof - = ! Di;w;.!;‘ui;lﬂﬂwnmm wan emmuc«wmr
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System Catalog Tables and Views

Schema Table = SYSIBM View = SYSCAT

SYSTASLESE

_ | information Management

Data Types

VARCHAR
LONG VARCIAR
&0

GRAPHC
VARGRAPHIC
LONG VARGRAPHC
DECLDE

SYSTR‘GDE = ) \GICPAZ FIR BIT DATA
SYSTRIGGERS:
SYSUIEWDERE p
SYSVIEWS T e £ Lo bo b d
At [ et
E ! DBZIB&"‘I':&;;\XB[:HMR;;}- T __I:'RQ;'! T omm;-c;;;;c: | ';"" - [-" DB!!QST:M»Q!![\L;;;:B;].“-“L""" - Tﬁ;d‘ © 2008 WU Caperntion
| Intomat on Managément . =k

CREATE TABLE Command

» You must have SYSADM or DBADM authority or CF\EATﬁTAB
privilege on the database

» Example:

3 I DE2 A5 Trairien w05 (1434 rch-2008 TNt & 2008 AT Corporption:

Table
» lEa elsaeatedmﬂmﬂ-ewdatse.ﬂ“ﬂ!baphced.

the IBMOEFALLTGROUP ahts spate (7 1 exsts and  tha pags size Is sufficient)
/haLsaaealedub’espacevwﬂchisn!h-sm&‘ﬂpamﬁzemg)hsdrmmmelab?e
Then &t wil go b LISERSPACET (@ 1 exists ard has a sulficlend phga size}

. gg;l;l BNDEX N, and LONG IN ciauses 1o specify the {ablespaces lo slored related

» Toduplicaten !ahie /',, ~
- CHEATE TABLE tabtrewiIkE by

= Ne oonsualnts, trigyers, of Indexes copted, and dala not copaed ,/'

. May spacify lable or view /./ /.-'

I

_/' -TodeﬁneatablensingSQL tatement /’

- mEATE TABLE 110w d
ELECTe om:s, 10 FROMt1) Vs

« Column alts é Safined table besed upon féfarenced tzble
+ frata ot popyldied up?

/ /

£

un 02008 Tl Corponatin
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Other Useful Table Commands

= LIST TABLES
~ List tables forthe current user
+ LISTTABLES FOR AL
~ List gl tables defmed In tve databasa
« LIST TABEES FOR SCHEMA <schemas
- List ladies for the specfied schema
« DESCRIBE TABLE <tgblename>
— Showihe strcture of the

|

oo .| sotomaton Management
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Insert Statement

= You need to have appropriate table or view privilage

» Can insert one or more rows at a time

INSERT INTO deparbment {dopino, deplnamae, admrdept)
VALUES (E31", 'ARCHITECTURE, EOT'),
['E32, INFRASTRUGTURE', 'E02)

» You can usa subselect to determing values

INSERT INTO department {depino, deptnanma}
SELECY depine, depiname FROM sales_depls

= May also be dona lo a subset of columns provided:
— A column not specified accepts NULLs oF
— Columns defined WITH DEFAULT

» Large amounts of data? Look al using LOAD instead

- [ Daeui‘:‘li:bgw‘ts?(lm . O??“Eﬂmwﬁﬂ M T vaz-s-:.—;;i:»ossmmm JE -] © 200 [BM Corporriion
|ifomation Management } Woformation ) o
Update Statement Delete Statement

» UPDATES come In 3 main varieties :

— Full tably
UPDATE employee SET salary = NuULL
LIPDATE employes SET (dept) =
SELECT depinams FROM depariment WHERE deplni = 1}
-~ Searched with a WHERE clause
UPDATE employee SET salary = salary * 1.10 WHERE tifle = ‘PBA
— Positionad using a CURSOR in a program
EXEGC SOL DECLARE C1 CURSOR FOR
SELECT * FROM EMPLOYEE FOR UPDATE OF JOB;
EXEC SQL OPENCH;
EXEC SQL FETCHCHINTO .. |
if { sremp {change, "YES") = 0)
EXEC SOL UPDATE EMPLOYEE
SET JOB = :nawjob
WHERE GURRENT CF C1;
EXEC SQL CLOSECY;
andif

2 I D82 v25 Trafining V0.9 (14 Ahargh 2008 1208

© 2008 EA Cénporanicn

= DELETES can apply to sing'e or muttiple rows
— You can akso use subselect to determine vaiues

= Two forms of statement :
- Searched DELETE form ks used to delele one of more rows
« Oplionally determined by a search condiion
— Postioned DELETE form is used to delete exactly one row
+ Dslermined by the current position of a cursor
= Deteted rows not removed from lable
— Spacae is marked as unused
— Reclaim space using the REORG command
« Example:
DELETE FROM DEPARTMENT WHERE DEFTNG = "D1t'

ELd l DE WS B Training ¥0.99 (14Ut 2008 hL-rol) © K08 B Soportfion.
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Select Staternent

» SELECT Is the QUERY element of the language
= Querles come In many styles:

— Retrieving all table data

~ Limiting Columns or Rows retieved

-} Irformatin Macegement

ORDER BY Clauses

= ORDER BY clause

— The ORDER BY clause specifies an ordering of the rows of the
resuft lable

 IFa gingle sort specification {one sort-key with assoclated direction)

GROUP BY, HAVING Clauses

= GROUP BY ... <grouping expresslon>

- AGROUP BY clause cortains a gr eniﬁetmad‘a!ammtab!
mqgwﬂselaﬁgmgdwmumer of the previous ctausa of the
SELECT workdepd, MAX ( safary ) FROM employea GROUP BY werkdept

= HAVING clavse

~ The HAVING clause a‘@ammamed‘alemmtabrehatcmés!sof groups of Frior
ichlhasearch‘conm%ﬂlsmﬁ s Ihe resul of the previous Clatse of the Subseiect.

SELECT workdept, WX [ salary } FROM emglopes BY workeept
mum[x(smmdsmrm(waysmuwme).

= Obtatn dstingt value from a fable

SELECT DISTINGT (peson} FROM emgloyee |
= Useof LIKE

SELECT DISTINGT WORKDEPT FROM employse WHERE WORKDEPT LIKE ‘A%
* Use of EXISTS

SELECT empna, salary FACM employes
WHERE mTEﬂSTS(SELEGTmFmMmqs)

s Useof IN, NOT IN clauses
SELEGT enpaa, sidary FROUM empioyee:
WHERE depastment I [ 'ADD, BOY, TWY |5

n ¥ Ds.hss-mhh-avauw»a-m 152011

1 2008 K5 Coportion

— Carteslan Product s dentified, the rows are ordered by the values of that sort

— Inner Join specification

— Sef operators — i more than one sort specification is identifisd, the rows are

- Commeon fable expressions ordered by the vakes of the first identified sort specification, then

-~ Other options: by the vales of the second identified sort specification, and s on
» derived columns — Exampla:
+ sub-query ele.
+ sorting SELECT ci, c2 FROM 11 ORDER BYc1
+ using fuactions
* geouping values
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Chapter 1: Contest Environment Walkthrough

Objectives

In this exercise, we will leam: -
¢ How to configure your environment.
How to boot up the programming environment using VMW&IG
How to log in and start up necessary services and system software
Examine the sample application which will be used in the progr. ammmg contest
How to perform programming using the GUI environment
How to use DB2 in command line mode and GUI mode

Exercises o . |
1. Log into the PC using the username and password provided by instructor.

2. Open an Explorer and then navigate to E:\

. Fia Folder 5)j2011 15¢ ot
92,123K8  Application 167312010'16145

{8 = Local Disk (7] L
& <o Ll Bidelt -
8 {3 polyu-20i1-v3 &

® £ Programaming Coni

1 4 Local Disk (1)
2 DVDRAMDrive(G) ﬁ?




3. Select and double click the program VMware-player-3.0.1-227600 to install the
VMware player. The following screen is displayed:

Welcome to the installation wizard for VMware
Player

The installation vdzard «ll allow you to repalr of remove Vivare
Player, To continue, dick Next

VWARMING: This program s protected by copyright law snd
international beaties.

Keep pressing Next and adopting the default choice until VMware player is installed
successfully.




5. Using the Explorer, navigate to the folder E:\polyu-2011-v3 and the double click the
VMware virtual machine configuration file with name "Programming Contest 2011
Enablement" and then boot up the VMware.

Visnare vitud dsk fle /1011 16:38

= Py Daamments ‘2KB Wam\?tudmadheconfwatim 5_}1{2811 15:03
3 £ Adobs 2,089,856 KB VWwware vituad disk fle 5{1f2011 15:38
£33 Adobe Scripts 1,239,744 KB Viware virtual disk file . 5f1j2011 15:38
£ CBBuriiorkP Projocts 1,009,152KB  VMware virtual disk fig Sl201t 15:38
£ Dowrdoads M 2,030,400KB  YMware virtual disk fite S/tf2011 15:38
£2) My eBooks . 2,095,552KB  V¥Mware virtuad disk Fila Stf2011 15:38
£ty Music ;g—;i 2,060,416KB  Vivrate viriua! disk file BJt}2011 15:38
2 by Pictures ) i@ﬂ'qgm Contsst 2011 Enab’anent 5907 32,0026 VMware vitud dekfla 512011 15:38
23 My Shapes @ﬁogammcwest 2013 Enabhrﬁﬁ 008 128KB  VMware virtusl disk Fle 5112011 15:38
&2 ty Videos I
£ Probop i
5 £ Safeiet Sentine! 1
% £3 SOL Server Mmagemeri: A
@ L35 tpdatess E}i

B8 e sl Sk NS

6. The VMware is now being booted ﬁp. You might see a pop up window telling you
floppy0 is not available. Please "No" and then proceed:

mm'ﬂ%wwmmcm@mwms avatatie on

Doyuuwarﬂ:tobytomm&iswtualdwke evexyumynupo\sermtiwwm&
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During boot up, you might see the following screen asking you whether you want to
download the VMware Tools update. Press the button "Do Not Download" and
proceed: '

{

Lastly, you might see a pop up window asking you fo restart the VMware, press the
button "No" and then proceed: ‘

mMMvadeNarmgmmlowe.
] Tocks, o .




9, When the Windows XP is booted up, the following login screen appears:

[ Ay mromamming Contest 2485

Tt is possible to click the full screen button (’éhe icon within the black circle) to switch
the booted system to full screen. This is shown as the following screen:

Under the full screen, you can put the mouse button to the top of the screen to activate
the VMware manual bar, and then you can go back to windowed mode by pressing
the corresponding buttons in the manual bar.



10. Click "db2admin" and enter the password "password"” to log into the programming
contest environment. The following screen is displayed:

181 Inter - Univemit}?‘?régrémmifﬁg Contest 2011

Jantary 28, 2041 B
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 Cliftons,Central §

2508 softwarn
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11. Open Control Panel, select Network Connections, and then bring up the LAN

12,

properties window. Then select "Internet Protocol (TCP/IP)" then press the button
"Properties”. The window "Internet Protocol (TCP/IP) Properties" is displayed. Select

"Use the following IP address" and then enter the IP address provided when you were
enrolled into the class. Use the Subnet mask "255.255.255.0".

Thi etreatBonuses the foloning tene

3 Yozean Pawaw‘um; y .
{g e Prerieied A0 PR A l_ | ‘uwﬁ"l i mwwa«mmm_

ODtlahmPedﬁm auoraticaly

B Maos Paddsm
=] Y Pan‘dtmmxnafn-suczmw

+ ) Uss the feoriog P adese:

Press the button "OK" in both windows such that the new IP address is set up l

effectively.

You can bring up a command window and the run the corﬁmand "ping 192.168.10.4"

to velify the IP address is set up properly.

: gP1ng1nq 192.168.168.4 with 32 hybes of data:

fReply fron 192.168.
fReply fron 192.158.18
EReply from 192168,
fReply fron 1920168,

ics For 192.168.10.

1.

‘Rpplay
E Hinirue =

tine{ins TTL= 64
tine{i

timedl TT
tinediny T1L-

4. L =@ Uz loss2?,
11 rnds
. fAuerage = Brs

CisDocunsnts and Settings dbZadmsind
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13. The next task we should perform is to can start the RAD (i.e., Rational Application
Developer) to look at a J2EE application which will be used during the programming
contest. RAD is a GUI development environment which is used to perform J2EE
programming. The resultant programs will be published to WAS (WebSphere-
Application Server) so that it can be executed in the web environment.

Double clicked the icon "IBM Rational Application Developer" to start RAD. A

banner will appear and a Workspace Launcher window will appear which allows you
to choose the base location of the workspace:

Letus [T

. [ Rations! [T IBM Software
Lavmsiiny. peasavak. -

Lyt Wil . ey o Sad e, THU STp e A iy BET 208
PE= 34

Cllck the "OK" button to adopt the default value wh1ch is"C: \Documents and
Settings\swg\IBM\rationalsdp\workspace".

———




© £ Qdeed
1 & 33 wastsbprofect

On the left side is the "Project Explorer" folder which contains a list of all available
projects. In the above window, there are four available projects (i.e., Q0-project, Q0-
web, WAS-lab-project and WAS-Iab-web). QO0-project is an application which
produces a course report, and its program codes are embedded in the project Q0-web.
WAS-lab-project is an application which performs a distributed transaction, and its
program codes are embedded in the project WAS-lab-web.



15. Before we start to review the program, we should start WAS (i.c., WebSphere
Application Server) such that the program can be run via a web browser (i.e., Internet

Explorer in our case).

Click on the 'Server! tab in the middle-bottom view. You see the "WebSphere
Application Server v7.0 at localhost' is stopped at the moment. First click on the
server, then right click to show the command manual, then choose 'Start' to start

WAS:

5k -85 waslabproject
@8 waslbweb

Q r{y;?ﬁh; text .

akeshitew ¥

G,
Ly
Delota

CHERES
o kP

B Add snd Remave Projects, ..

1 [ Create tables and data sources
Recemnst debrugmoosss
Server canfiguration

Unfversdl test dhent

Then you will see the state of the server changing from 'Stopped' to ‘Starting":




If you click on the tab 'Console’, you might be able to see the system messages
generated during startup:

EaaavaaTvaTT Spave Dighlay Curzent Envirgrassnt BteeTEeveve

tergphere Platforn 7.0.0.3 (BASE T1.0.0.3 C£Q30511,09) runoing with proccss hq'
Host Operating sysbeu iz ¥indows 1P, vecsion 5.1 build 2600 Sexvice FPeck 2
Jave version = 1.6.0, Java Corpiier = 3931t24, Jeva VE paee = IBE 35 VR

yua, inezall.réot .= CriProgrem Files\IBPM2PPirancisezibaza 7

nseri kretall . root » Sr\Frégres Files\IBMS$DPirunticesibasg v')\p«ozne-wu?n;
dsve Eome = Cr\iProgras Files\IBE\SOPipustiz=pibess V?‘.ja\'a\gre

wo.ext.dirs = CilProgram 7iles)IEM3DPiruncimeeitese v7/aavas ik Cr\Frorran F
Elafapath * C1\¥rogues Filest IBAYSDPYrunti=sistbese wYiprofilesivasiiOprofslé
ava Library patk = Ci\Peegrsn’ Files\ IEN SR\ Eunnimesibass - v Javaiireibin .
svnstsssrzaer End [iaplay Sarzent Envirenmant 3irsasrrssrs

[1/4/11 11:84:231621 C5T] GOLOOOO0 HodelkEgr I




After a while, WAS is booted up and the state of the server is changed to 'Started":

16. Now, we can continue to explore the project. Click the "+" signs of Q0-project and
Q0-web to view the content of the projects:

paikage cow.ibm.aglidava;

&

1% Pisport Java.sat.er

Esiyl ftersesr vparselass(Siring, Etrieg, Lering, fnt))
Feal iyerstor FEgulcybizt{int, Ztringl;
Es3l copiexc TN}

{: peblic orass DatapasclocenabzingSQLY

) public statiec Arraylist getFecultylist |Conceccion con, SarvietCatputst
Aecaylist faculrylist = new Lrrsylasc();
TetulcyLisc resulcs}

y bohs secutyEdter

. tJ:i\msl.u‘a.m;-a.mrg

© BB sduois
= o Webronnt

b B3 wask 3 int feculylf = 0:
z%z . im String facultyReme = nukls

try o
£ty thisCTE = hew crricon}s

#eql {ThirCTd} result=={SELECT * FPON FACULTT} !

ds {
#zyb sFETLE dgezalrs INTO (facnlcylf, :fssnlboyijuealy

O hpnyin




Further expand Q0-web by clicking the "+" signs of "Java Resources", "JavaSource",
and "com.ibm.sqljdemo” until you see the 2 programs of the application (i.e.,
CourseListServlet.java and DatabaseAccessUsingSQLJ.sqlj). Double click
"DatabaseAccessUsingSQLIsqlj" to edit this program. A new sub-window is
displayed on the top-right portion of the window. Please refer to the above screen.

17. Now, let's see the output of this program. Open a Mozilla Firefox browser, and then
select 'Bookmarks -> Q0 — Course Selection' to run the program Q0. The followmg
screen is generated:

{319{7-3 o\‘ﬁié g%ﬁgthn)’_l& ‘\7&?\‘—_‘21%‘.1" T NaAr by
Gptional Comr'ses
4t . _in N
(.-CD:;S: Title ‘];;it:! tyg Uit
ENGO104  Engineenng inzthematics Engineering 3
ENGO106  Digtal logie Engineering 3
ENGO107  Foundatisns of computer science Ehgineering [3
CSE0120 Compuler programring 1 Engincefing 3
CSE0122  Compuler programming ¥ Enginzering [
Introduction te data shruttures & L.
'CSEOHQ alzorithms Engineerinig [
CHI0102 Putonghua course for Engineering students Acts 3
SOCO0118  Japanese soticty Social Sciences 3
ECO0213  Micreeconomic analysis Business [
BUS0102  Introduchion to accotnting Busintss §
PHYO017  Rencwable energy Science 3
STA0102 Linear statistical analysis Science 6
AMRO0O2  TIssues in Americen business: Wall Street  Arts 3
MUS0210  Music of China Agds [
POLGO20  Hong Rong politics Social Stiences 6
SOCO008  Culure and seciety Social Scienees 6
FINO101 Financial markeis and institstions Business [
CHEO013  Chenistry and Jaily ke Stieate 3
ELE0115  Flectronic circuits Engiacering 3
ELEO112  Computer microprocessors Engineening 6
fcoursEcobE 1 Seteat ]
{Offering Fotulty 55 | Fiter |
List of Facully  Shewborder .




18. Now, we modify the program Q0 to reduce the lines of output. Scroll down the edit
window until you reach line 107:

ArcayList qoursel.}.sc = ney Areaylizc{):
Couczebist results=;

& 15 gopro
B Qowed
i é}%wm;nbtm:sqmdﬁeb; 8 String courseCode = nulls
& P8 s Resources string coursefams = nuil:
S 8 JvaSouce . string offecinpFeculvy = null;

- &2l o bmsgidere H int nafredits = 0;

by §
ot¥ thisCTH = new ctx{con):

- if{spleccCourseCode. trim{) .tollpperCase (} .compareTa {*COURSE COL;

elsed
’ H3g1 fchieCtd] resalts={3LLECT COURSE.CIDE, COURSE.TY
¥

#sgl (FETCE sxesults INTO iooursaCide, icoutsedmsd, :dife

if (repuits.endFecchi) != true)i
courselist.add {courzeCoda)}
; st s

vt

The above window shows the SQL statement "SELECT course.code, course.title,
faculty.name, course.unit FROM COURSE, FACULTY where course.faculty_id =
faculty.id" which obtains the list of available courses. This statement generates the
list of courses and the resulis are displayed in the Internet Explorer.




19. Let's make some changes to the application. First of all, click the "Project" item under
| the manual. It can be scen that there is a tick beside the item "Build Automatically":

] 3 Sranogt
[ : 3xefrmiat

Fnsde
ERifnies

€han,., reelist reaults;
Buid Avtemnaticely

) ] Butd Working Set ayList courselist = mew ArrayListi):

it 2 Ok el cadec . iny courseCode = nukls
e — e e s e - o ding CourseNems = nulls
. X ing offeringFaculty = null:
i L ; int nunCredits = o
i E CoursetistServist-jave
+ 13 iphsiadsnisnd i) A by d

) " T otx thizCFX = new ctx{ton):

( £ L EG if{selecclourseCode.xrim() .r.nUppetCase[),cumpareToé"COUFSi:'CO!' 2
i 1f iselectFaculuyId == ~1}{ i b
Y sFEqiiienieIN]iTesnlta=i SELEC SEL
¥
else{
#ugl {EnisCTR) tesulte={SELECT COURTE.COPE, COURSE.TI
g ]
| .

eXso Feql {this{T¥] ¥epualeas{SELECT COURSE.COLE, COUPSELTITLE,S

do {
gsgt (FETCH :srégults INTO :courséCods, icourssMawe, toffe

] if (cesults,endfeteh() 1= trubld
courszelList . add{coursacaode):

1 This means that after you modify something in the program and issue the save
command, the project will be rebuilt automatically and the change will be deployed to
WAS automatically.



20. Go to line 107 of the edit screen for the program "DatabaseAccessUsingSQLJ.sqli",
Modify the SQL statement by adding a where-clause "where code like 'CSE%" at the
end of the SQL statement:

ArrayList courselist = new irrayLisci}:
Coursebist resultss

.., & %Deplmwmweso’qiu, sqensweb] & string coursefede = null:
= =35 Java Resauces : String courseNeme = nulld

=} }j‘BJavaSa.rce Scring offeringfFaculcy = noll;

H

2 J conbrsdicuno . int numCredics = ;

try {
cti thisCTR = new cex{con)i

ifigelectCourseCoda. crinl) . coUppecCasa (} .::omparemgﬂcc-up_sz sof,
:l.t(selet:r.raculcyll) == -1} ¢

E=it {thisCTA] fesalbs={8ELECT COURSE,CODE; GGURSE,TI-
]
} ) =
else #oql [thiscTX] resulis={SELECT COURSE.CODE, COURSE,TITLE S

do { .
#sgl {FETCH :results INTO :coursecods, icoursslute, soffar

if(rgaults.end}'etch(} I= h:ua]{

This will restrict the result of the SQL statement by only retuming the department
names starting with 'A' only. The character '%'’ is the wildcard character which
matches any strings.




21. Press "Confrol-S" to save the edited content. At the same time, please note that in the
bottom-right corner of the screen the following message is displayed

Building workspace (0%)

Please refer to the following window for an illustration. Please take attention to the
circle on the bottom-right corner which shows the message:

==y . AreayLisc coursehist = hew Arraylist{):
QO-profect Coursekist rasulta;

2

gqom .

5 B3 Deploymerit Descriptors sgDemaWebs . String courstCode = pull:
i %8 JovaResources . String tourseMawa = null:
Strinyg offeringFaculty = null:
int numlredits = 02

tey {
ctx thisCTX = new ctx{con)

if (selectlourseCode. trimi} .tolpperCaze {} .comparafo{"COURSE t'ofl;
if {gelectFaculsyId == -1}

}

H
eslse Feql [thiacTH} resuits={SELECT {OURSE.CONE, COURSE.TITLY,Fx

do {

iffresules,2ndfetchi}
s

After a while, the project rebuilding process is completed and the message will
disappear.




22. Open the Internet Explorer window, and run the application again (or you can reuse
the originally opened Internet Explorer and press the reload button). The following
screen appears;

Opfiotial Courses

Cowrse . Offering .
Code Tide Faculty Uit
CSE0120  Computer programming I Engineering &
GSE0122  Computer programming I Engineering 6
Introduckon to data structurzs & .
CSEQ119 Agorithrns Engineering 6
[CouRsECotE | [eelest]
[Ofering Faculy &) | Fier, ]
. _List .ofFaéul;g S‘hpw hg}de(i

Please note that 0 the course name with prefix "CSE" is displayed. This indicates
the new SQL statement is effective.




23. Since there is a tick beside the menu item "Build Automatically"”, the project will be
rebuilt and redeployed automatically for every change to the project. If you want to
perform multiple changes to the project before you rebuild the project. You can twrn
off the tick of the menu item "Build Automatically". In this case, you have to select
either "Build All" or "Build Project” to manually start the project rebuild process.
This is shown in the black circle in the following diagram:

Open Project

= M
[FiBuld Al

Build Automahcally

Dployment | Copwert to-a Dyname Web projest,.,
:Java Resour: A :
gﬁ JavaSout-
(=3 gﬁi“ corn.ibm. sqljdemo -
D @ CourseListServiet, java
- Jo] Databas e SRREQEISEI

B-58 sQL)avasource
B2 Libraries
&8y Security Editor

l Web Site Navigation
EI-% SQL}An‘cSEr:pts
B2 WebContent
Ei % wWas-lab- -project
m-d W#,S fab-web

Pmperties

int

t.'r_*'g

e e errenn Eﬂ‘ %[ﬁbg .8

Please also note that when you change a program, there will be a symbol "!" beside
the affected objects under the project explorer in the left side of RAD. Please refer to
the blue circle in the above diagram for an illustration.



24.To review the DB2 database environment, open a DB2 Command Window by ]
clicking the following Windows menu button: Start -> Programs -> IBM DB2 ->
DB2COPY 1 (default) -> Command Line Tools -> Command Window,

25, The following DB2 command window appears:

Please note that all DB2 SQL. statements and commands must be entered to the DB2
command windows before they can be interpreted by DB2 properly (i.e., normal
Windows command window does not work).




26. Execute the command "db2 list db directory” in the DB2 command window and you
will see there are three databases (i.e., SAMPLE, ‘MF and REALMF) defined in the

system:

EC: ~Pragran Files \IBMNSQLLIBNBIHD>ER2 list dh divectory
- Bysten Database Dirvesctewry
E Hunber of epteies in the divectory = 3

;Dat&haac 1 entpyt

REGLHF
REQLHP
DEY
a4.68

1 Datahaz
. Datal
] Hode

al

Renote
SERUVER
-1

wnnog koo

E Cataloy database -ition nucher
E N1ternate
f Alternate seyrver port nunhsy

nn

flatahase 2 entry:
b u

Database alias
E Daiabase nans
E Hode mane
E Datahase relesss lavel
= Cannent
E Divectory entry typs
E Cataloyg datahase paréition nunbher
* filternate servew hestnamsz
E fiJternate server pors nunbher

:ﬁatahasc 3 entruy:

E Datahase alias

E Database na
B Local database divsctory

E Datahase relsase Ieuel

. Conmnent

E Dirsctory 7 ndivect
E Catal aba iC ke nunber 4]

E tlternate arse

E flternate server nart nunber

EC: \Progran Fi IE?‘%\‘%{}LLIB\PH‘;X
W

. The database SAMPLE isa databasc deﬁned in the pnmary mstance (DB2) in the
local PC. The database MF is a database defined in the secondary instance (DB3) in
- the local PC. The database REALMEF is.a database defined in a mainframe serverina
remote server. We wxll access MI and REALMF in the Iater chaptcrs

v-nk-nw"

wﬁwmﬁ'm'-_;e

e




27. Enter the command "db2 coanect to sample” to connect to the SAMPLE database.
The QO-project application is configured to query the SAMPLE database:

ECo“Progran Files\IBHSSLLIBBIH&HZ sonnect o sanpls
}  Dacabrase Connectien Informatien
P Database server = BB2/HE 9.72.68

Bk SGL authoxization ID = }Béﬂﬁﬁlh
' Loeal dacabase alias = BAMPLE

B C:Progran Files\EBNSOLLIGBLY

:C:\Prﬂgran FilessI BB SQLLIBNBIN>dRZ 1iet tables

Schena Ty Creati

2R 268912 .37.88.827882
BE2ADHIN ’ 260%-12-29-11 .37 .14.0686862

2 vecordis? selsctod.

EC:\Progran Files\1BHNSOLLIBNBLR)




29. Enter the command db2 "SELECT code, substr(title, 1, 50) as title, unit from course"
which is a slightly modified version of that in the program
"DatabaseAccessUsingSQLI.sqlj". The only change is the addition of the substring
function which trims the TITLE column to fit in the window. Refer to the following

screen for the results:

'C:\Bacument’c and Settingsidh2admninddh? “select code, subsitrd

rng1n9311ny
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FToundations of compuber scichce
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30. Finally, enter the following command "db2 describe table course" to display the
* column definition of the table COURSE: '

r and Settings dbZadoin>dbh? deszcribe table coupse

Baka Lupe Go lunn
pata Lype nang Lanyth

CIE

URRCHAR

[RTEGER

iHTEGER

SYSEBH 1HTEGER

+ vecord(s? selected.

EC:\Docunents and SettingssdbZadminr.

31. In general you can run SQL statements by putting each statement after the command
"db2". You need to double quote the command in case it contains wildcard characters.



32. Now we will try to use the graphical interface of DB2. Run the DB2 control center
from "Start"->"All Programs"->"IBM DB2"->"DB2COPY1 (Default)"->"General
Administration Tools"->"Control Center":
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33. The DB2 control center is displayed. Press "OK" on the Control Center View to
accept the default view:

(@ Helo x;

rrent vieer of the Control Centert bdvanced .‘




34. In the Control Center screen, navigate to “All Databases"->"SAMPLE"->"Tables" on
the left pane and then the list of tables will be displayed on the top right pane:
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35. Click on the table COURSE and the field definition of the table will be displayed on
the lower right pane:

SYSTOOLS SYSTOOLSPAL.,
SYSTOOLS SYSTOOLSPA...
SYSTOULS SYSTOGLSPA...
SYSTOOLS SYSTOOLSPA,.
SYSIEM  SYSCATSPACE

R R I B

&R Table - COURSE

£ Tebte Spaces

€3 Event Bonkors Schaeng' - 7§ pEZADMEY
G2 nitaross o |t
£33 Apckeation Obicts
- (33 User and Group Objects Adtions:
[ Federated Datsbase Objects & Qoen
o[ 304 Schema Reposkory (xR Faluer

¢4 Show Refated Objacls

& Create New Tahla




36. Double click on the table COURSE and then a new window is popped up to display
the content of the table:

] i =5

. Engineering mathema, ..

ENGD106 Digital togic
JENGD107 Foundations of comp...
BCSED120 Comnputer programni, .,

fcseoiz2 Computer programivl,.,
Ecsenitg Introduction te data ...
{CHI102 Putonghua course for...
ESOCDIIS JJapanese society 5
gECOD213 Microeconaraic analysis 2
BUS0102 Introduction to accou,..
PHYOD17 Renewable energy
STAc102 Linear skatistical anal...
AMROOOZ Tssues In American bu, ..
MUSsez10 Music of China
POLO020 Hang Kong politics

Culture and sodisty

50C0008

Financlal markets and..,

Chemistry and daily life

Electranic drcuits

Computer microproce..,

piwwlelo|loiojw|lelulele(we{ele|loiolowis

[ SR (IR UUR I | R U U Y I e e I = = == =Y

Frmredon e

Fetch f\"lore Rows 1

Spend some time on reviewing the functions of this window. Press the button "Close"
to close the window.

37. Spend some more time to understand the other objects (e.g., indexes) in the database
and functions of Control Center.




38. Then we will review the DB2 Command Editor. Execute the Command Editor
through "Tools"->"Command Editor" from the manual bar of the Control Center:

D 0 DRZ200
ContrfCorter  Seletted EdR ¥iewm

£3 Corirol Center
-G53 M Systens !
2 23 Al Databases i
a4 GFw i
1

%f@%%a%@ggm

e

Rephcation Center
Satete Administration Cenker

SAMPLE - Tables ]
= | Swemas | Tabks spate s | Commert & | Index tebls spsce 3 | Largs dota table space 3 ] Type S [ Cardy

"L Corfguration Assitant
| Customize Contred Certer... IoN  SYSTOOLS' SYSTOOLSRA...
£ (3 Abiases e e e s s SYSTOUS SYSTOOUSPA..,
T2 Neknarmes Tocks Settinis SYSTOOLS SYSTOOLSPA..,
$1-() Coche Objects
; (53 Triggers
E - {3y Sdhemas -
1 - Indexes
1 (59 Tebls Spaces £8 Table ~FACULTY @Hﬂﬂ. %
¥ £33 Event Mordiors S:h_ema :DBZADMN Cohmns
£ 02 Buffecpocs ?m 2 rey | Hime Ditabyps | Length Wdzbls
3F {5 Apcication Objects ’ T f L
{2} User and Group Objecls Adtions ARCHAR 5] Hes
() Foderatod Databasa Ohjscls & Coen
11 e, setensa Repostory ts0) 8 fert

HE) Show Retated Obleds
H B

; JR U —

I ;!:_tgg]zﬂgg ama‘.




39, The Command Editor screen is displayed. You can type the commands in the top
pane and then the result will be displayed in the bottom pane. Type the command
"connect to sample" in the top pane and then press the run button (i.c., the green
triangle button) just above the top pane:




40. The Command Editor will then log into the database SAMPLE:

connect to sample

Ty o B YR S T LS KT XTI Ty LA W R T T =X {07 ¥ A2

connect to sanple;

connect to sample

batabase Connactiocn Information

Database sarver DBZ/NT 9.7.0
SQL auvchoerization. ID DRZADMIN
Lotal datahase alias = SAMPLE

A JDBC connection to the target has sucseaded.

You can run SQL statements just like what you did in the command window. But you
don't need to prefix each command by "db2". .

Now please try the Command Editor out by entering more commands and see how it
responds,

41, This is the end of this exercise.
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What fk Event Management? - Extended into

Complex Networked Enwronments

» Large complex Mfra-slzﬁcmes Increeshgly inferconnected by variety of providers

* Eves ngreas on beadwioth fbroadband for new “irple play” sesvices
bl h‘%ge&éﬂdm higher “riple play feg

= Malnlaining klgh QuaRy of Service (QoS} ts key for multiple sesvices sharing the same network
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problems
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at are Probes?
Probes are software componenis used to collect event
Information and send it to the ObjectServer,
Probas anable the ObjectServer to be independent of the
systems or devices being monHored,
v Over 300 fypes of probe
= Both genaric and vendor-specifie probes exist
Probes can medify and enrich event Information
+ Use additional information from lookem kibfes
= Perform arthmeti: funcfons
Probes are resitient
* Refable TCP connaclon
« Siore and forward functionaEy (SAF)
* Asfomate fall-ovar to atternats ObjeciServer

SR

What are Probes? (contineed)

+ The ObjeciServer obtalns most of its event data via the probes
= Event dat may be alse obiained via Auomations, Tools, Gateways or SQL
+ Every probe comprises a binary, a rules file and a properiles flls:

+ Probe blnaiy retrieves and lokenises svent streams, and sends the svent to tha
ObjectSener.

interpreted niles e used b populate the field values within alerts stafus
* Properfes fles delemins the run-time settings of the probe.




® Coflaction

and event synchronlsation

= Normalisation

= Normalisation
* Enrichment
= Human Readabllity

s Pra-classification for ObjectServer Correlalion and
Netcoo! processing
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Netcool Omnibus Probes

« Source-specific code for integrating with 59 parly systems

» Standard protocois: SNMP, Syslog, OPBC, 3GPP...
» Custorn message formals: Sockel, Logfile
« Proprietary/API: Many Vendors

= Common code for rulas-based avent processing:

Netcool Omnibus Probes — Rules File Example

i Etng

® Base Flelds
_« Identifler
= Severily
» Node
» AleriGroup
= AleriKey
= Smmary
= Ageml
= Type

Types of Probes
¢ Device
* Logfile

+ Database

+ API

¢« CORBA

¢ Miscellaneous
* Secunty
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Event Clear Trigger and Dashboard Status
Update Demonstration

* Postzmsg

» Omnibus IP and receive poris and put it info a config fite
with the below contents:

*
.
# 11canind Moteriols - Prepecty of I0d
¥ "Reskricied Hotaricls of 18M°

2
# Sz=ple progroe Hile shoslng wpdetes foe OUNTERS 10 a1low erser
events to ba deat to EIF probe

- "

# (L) Coppright I8 Corp, Z0OT ANl Rights Résprvad.

*

&
L4

Serveriotation«137.188,18.5
StoverPortadal

#hut Ferfvgnt s~
RefEviPatha/tmpsibe syne_error cothe
ol EvtHaxSlze- 1295

Syn

Qanmm
— A AT

R ol
P atwoas

Event} t OMNEus,

£

tax for postzmsg

+ Create a BED color event:

» postzmsg.exe —f my.cont —r GRITICAL —m contest EventiD=101
situation_name="taam1" satualion_stalus="Y" Inlegration_lype="U"
stuation_origin=team1 sHvation_displayitem="1¢am?' leam1 1T

+ Creale a GREEN color for clear event;

= postzmsg.exe —f my.cont — GRITICAL ~m contest EventiD=101
sttuation_name="tearn1* saluation_status="N" integration_type="U"
situation_orgin=team1 situatlon_displayitemz1eamt’ team? ITM

ﬁ Dk 5{(\'{ [r i
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Any 'Qtiestlpljg?‘ .

Follow Chapter 2 Tivoli Netcool Omnibus
Exercise




Chapter 2: Tiveli Netcool Omnibus

Objectives

In this exercise, we will learn:
e Review server interface of Omnibus
e Review and change Omnibus client scripts
o Observe the reaction of the Omnibus based on client request

Exercises
1. Review the server interface of the Omnibus server as provided by the instructor

Bipsf1192,168:10.5: 1635 6fbmfconstle Sugin. dotsctio=st0u s

All the traffic lights in the tables are green in color. Now you will write a script fo
change the color of your table to red and then back to green.




2. Double click the folder "Tivoli" on the desktop, then select the file
"estevent_template.cmd" then right clicked it and then press "Edit":

<d ¢i\remp .
postzmsg. exe ~=f my.coaf. -r CRITICAL.-m contest EvENtID=1XX situatiori_name="teamy"
tustion status=Y" integration. types"u” struation origin=teamy
situatior_displayiten="teamy' tedmy ITW F
postzmsd, exé —F my, conf —r' CRITICAL -m cantest "Event1beix $ituation rames"tedmy"
§situation_sratus="N" integratioh_types"u” situvation_originetaany
s ituation displayitem="teamy" teamy ITM :

LKB. CONFFia
t92 KB Applcation g
e 148 WindowsNT Cotm.s 1/4/2011 7:27.Fi

send To *
Copy

Creaté Shortaut

Delite

then an editor pops up with the content of the script file displayed in the editor.

3. You can see there are two commands in the script file. The first command is to
change the traffic light of team<Y> to red, and the second command is to change the
traffic light of team<Y> back fo green.



4. Modify the two commands by change Y to your feam number, and XX =Y witha
prefix 0 if Y is single digit. For example, if Y = 2, then XX = 02. Then the two
commands will become:

postzmsg.exe —f my.conf -r CRITICAL —m contest EventID=101
situation_name="team1" satuation_status="Y" integration_type="U"
situation_origin=team1 situation_displayitem="team1' team1 ITM

and
postzmsg.exe —f my.conf —+ CRITICAL —m contest EventID=101
~ situation_name="team1" satuation_status="N" integration_type="U"
situation_origin=teaml situation_displayitem='teaml' teaml ITM
respectiire;ly.

5. After the two commands are changed, run the command "File"->"Save As" from the
editior and give a new name (e.g., testeventl.cmd)::

: gord o CAITIZAL -G Cortest EYatil=led $11ea1bon nant="taund
EEirati aLer i {n:eg;}lm. = Ut STnaLien it
sivntiooddsplydem="te 1) pit.]

pavre

Brosionso.ere f my.qonf ¢ CEVFICAL —m coniett Eybok]basgl SiTUITScn rase-"gaml
mcfz‘i%u‘.m?r m;eyfﬂm:;{;u“p" EERH R N

s v iedispladremet caamd’ end 1%

tpfel Tl P

= I TR s
S5 GGt e
i ke AR e
178 Srdoe T Conn L, AMPEIVIIF P
IR Erdom TG, PRI P




6. Double click the file "testeventl.cmd" to run the script file. You will see the
following window:

Gi\Documents and Settings dbZadnin‘Desktop IiveliZed civtenp
iThe systen cannot find the path specified.

b cBocuments and Settings\dbZadminNDesktepsTivelidpostensyg.exe —f ny.conf —» CRIE
IT1CAL —m contest Bventlb=16G1 tuation_name="teaml' situation status=""?" inteyraP
E-ion_type="UY situation_ewvigin-feaml situation_displagiten=’teani’ teami ITH :

:C:\Bucuments and $=ttingssdbhZadnin\Peskiop\Tivolirpause
EPress any key to continue

The first command is run and then it will pause and wait for your input. Don't press
any key right now.

7. Look at the Omnibus server screen. Wait until the traffic light of your team changes
to red. The screen will be refreshed every 5 seconds.

8. Press enter on the script window. The second command is run now and you will see
the following output:

-2 and Set¢ingssdhbZadpinsPeskitopiTivelired civtenp
-annot find the path specified.
sents and Settingsdb2adnin\Desktop~Tivelidpostemsg.exe —f ny.cenf —» GRIPE
: contest EventlD=181 situation_nane="teami® wation_status="¥" integral
Eion_tuse="" situation_prigin=teamd situatisn_displayitem='teani’ teani ITH

\Iocuments and SettingshdhZadmiaDeskteopaTivelidpauss

;C:\Hocunents and SettingsadbZadnin DesktopiTivelispestznsg.exe ~f my.conf —» CR
tion_nane=Yfeamt" =i cion__status=""HY" iptegr




9. Look at the Omnibus server screen. Wait until the traffic light of your team changes
back to green. The screen will be refreshed every 5 seconds.

10. This is the enc_l of this exercise.
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| * What Is an Application Server?

! » Application Server Archfiectural Overvisw

» JEE Packaging Overview

« Application Server Admintstration
» Inteprated Solutions Console

i ¥ Application [nstal
» Problem Detesmination

» JDBG Provider and DalaSource

[ » Dislributed Transaction

| o Lab {Review WAS-Jab application)
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Chapler 3: WebSphere Application Server Di

Agenda

« What is an Appfication Server?

» Application Server Architectural Overview

« JEE Packaging Overviaw

» Application Server Administration
¥ Inlegrated Soldions Consale
» Apphication lnstaf
» Problem Determination

+ JDBG Provider and DataSource

o Distibuted Transaction

» Lab (Review WAS-lab application}

What is an Application Server?

« Provides the infiastructure for running applications that run your businass
b Insulales applications drom hardware, operating system, database, network...
3 Provides a common envirorinent and programsing madel fer applications
.« Writs once, run anywhere (WORA)
» Platiorm for devetoping and depioying Web Services
+ Provides a scalable, rellable transaction engine for your entarprise
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The Java Platforms

The [ava™ 2 Platform

» Java 2 Micro Edition (J2ME)
An opltimized Java runtime envirenment
for the consurmer space. 1t eovers the
range of exiremely tiny devices such as
smar cards or a pager allthe way up io
1he set-top box.

« Java 2 Standard Editlon (J25E)
A complete environment for applications
development on deskiops & semvers,

v Java Runtima Environment, Slandard Edition (JRE] - provides the Java APls, Java
virtual machine, and other components necessary ko run applets and applcations
writlen in the Java programming kanguage

}» Java Software Development Kil, Standard Edition (SDK) - A supersel of the JAE
that incudes tools Such as the compllers and debupgers recessary for daveloping
appiets and applications,

+ Java Enterprise Edition {JEE) — formerly J2EE

2

A Brief History of Enterprise Java

Hibernate Seng gea
500
Porilets EBal
Nodrtedate view
BPEL Srgtetons
JavaEES Asyre, session bean

*ESB 3
POJD componenis Wb Berdces
POSO parsizienca

“ebServoes ohxes
POJO comparienty Bean validalion

195
B SAX ;
27 neetz = e
w o=, ,S:E.,; 23 Wl.;qm eamn EL
Sertazy (S0 oy HEEDwpomen  Awdions

© 2010 IBM Corporation

Java Enterprise Edition (JEE)

» Buitt upen J2SE, JEE provides the specifications for developing muti-tier
enterprise applications with Java

« Accelerates and slmplifies enterprise application davelopment
+ Weh applications based on standardized, medular componenis
¥ Providng a complele sel of services lo those components

» Standard APls for common services such as database access, bansaction
managemen, messaging, elc.

¥ Handiing many detatis of appication behavior automatically, wilhout complex
programmiag {e.g. bansaction management, security}

» Providing a fourdaion Tor the third parly component market (6.0, JOA, JK4S, JDBC)
» Irnproves syslems and operations management by providing:

} Packaging, deployment, and management standards fer enterprise sppicabions
» Fuitilis the promise of true portabliity
» Hardware, operating sysiem and vendoc

Fobs

JEE and WebSphere Application Serve

« Application servers, based on slandards, can be psceived as commodiles

» WebSphera Application Server (WAS) defivers more valua to customers fhan
Just standards compliance
» Cualty of service, such as
« Worldoad management
= High avaitabity and failover
* Performance
» Toofing support
= Runfime embedded in Application Developer producls
+ Piooramming model exiensions
» Fuhwe standards
» Cuslomer identified critical funclions
» FexmiaBion Jor evolving WebSphere Software Platform
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Agenda
« What is an Application Server?
« Application Server Architectural Overview
« JEE Packaging Overview
» Application Server Administration
* Integiated Solutions Console
» Application Insial
» Problem Dalerminafion
« JDBC Provider and DalaSource

« Distributed Transaction
+ Lab {Review WAS-ab application}

Administering the Server

'©2010 1IBM Corporation
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Application Server Base Topology
Singla machine, single node, web sarver separated
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¥

“Enterprise

Appiication
o Application

Assembly

E‘@ 2010 IBM Corporation

Overview of Application Assembly and Installation

Jor appyee

Agenda
« What is an Application Server?
» Application Serves Architectural Overview
o JEE Packaging Overviaw
» Application Server Administration
+ Integrated Soluiions Console
» Application Insta
» Problem Delermination
» JDBC Provider and DalaSource
« Distibuted Transaction
» tab (Review WAS-lab applicalion)

JEE Packaging
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Agenda
» What Is an Application Server?

« JEE Packaging Ovenview

« Application Server Administralion
¥ Integrated Solutions Console
+ AppRcation install
» Problem Delarmination

+ JDBG Provider and DataSource

» Disiibuted Transaction

» Lab {Beview WAS-fab appficalion}

© 2010 IBM Corporation

WebSphere Application Packaging

« Application Server Archifeciural Ovenview

The Ajpplication Server Toolkit Workbench

System Adminisiration Tools
« WebSphera Integealed Soluions Console
» Browser-based interiace
» Command-fine ¢peration tools
¥ Avattable in he bin directony
» wsadmin scriping
» Interactive and batch modes
» Suppors JACL or Jylhon scripts
« Ant
+ Java-based build and automafion ot
» Java-based JMX APIs
» Programming interface for custom Java applications

ST T R R R U
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Agenda
» Whatis an Application Server?
+ Application Server Archiiectural Qvaniew
» JEE Packaging Overview
« Application Server Administration
» Integraled Sohutions Consola

» Application Instal
» Problem Determination

« JDBC Provider and DataSource
« Distibuted Transaction

+ Lab (Review WAS-lab applization)
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Installing Enterprise Application

e

e e b b

Wta

Agenda
» What is an Application Semver?
» Application Server Architectural Quanvisw
» JEE Packaging Oveniew
» Application Server Administration
» Integrated Sclutions Consola

¥ Apphication Instalt
* Problem Dateteninalion

» JDBC Provider and DataSource
» Distributed Transaction

» Lab (Review WAS-lab application}

© 2010 1BM Corporation

s

Installation Tasks
+ Gonfigure the applicalion environment as required
} Variablos, virual hosts, classpalh, seturity, and 5o lorth
» Configure applicaticn resources
+ JOBC prowider, DalaSources
« [nstalf application

Logging and Tracing

+ Messagd logging (massages) and diagnostic trace (frace} are concaplually
simitar sinca they are using the same Java fogging APt

» They have importan! diffesences:

» Amessase entry Is an informationat resord thal is inlended for end ysers, syslems.
admishakors, 2nd supporl personnel o view, The toxt of the messege musk ba clear,
concise, and Interpratable by an end user.

¥ A trace enlry is an inforration record thails intendad fof sesvice engineers of
dovalopers 10 U50. AS sush, atrace record might e considerably more congler,
verboss and detaled than a message entry.




./ Proof of Technology

Log Files and Locations
« The destination and names for the log files are conngurab!e
The defauit focafion is:
<Was, roob\proﬁies\ﬂoﬁie_namm}ogsksewer_nam»
= LogFi Files: :
+ SysteraOutlog and SystemEmlog - Standard JV outpit and enrer 10g
» startServerlog and stopServertop
+ Slartup and shuldawn of the Application Servers
» acthvity.iog - Events that show & history of inslaliation actvilies
= Use Log Analyzet 10 read outpul from this fie
» trage.log — Outpi drom diagnostic race
» Destination and name are configurable
» htlp_plugindog —Natin <was_Tooh
= Location: <pfugin_roob>\ogsicwebserver_name>

» DataSource represents a real-world data sourcs, e.g. DB2 for 2/08, in the Java
programming languaga
» DataSource I3 segistezed with JNDI naming service for use in a JEE

anvironmenl [-X: % WebSphere Appﬁcalian Serve;

'© 2010 1BM Corporation

Agenda
» What ks an Application Server?
» Appiication Server Architectural Ovanview
» JEE Patkaging Ovanview
» Application Sarver Adminisiration
} Integrated Sotutions Consolg

» Applicaion Install
3 Problem Determination

» JDBG Provider and DalaSource
+ Distributed Transaction
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Agenda

« Whatis an Appfication Server?

« Application Seever Architectural Overview

» JEE Packaging Overview

» Application Server Administration
¥ Integrated Solutions Consele
+ Appication nstall
¥ Problem Determination

+ JDBEG Provider and DataSource

« Distributed Transaction

+ Lab (Review WAS-lab application}

Code Pattern

» javax.ttansaction.UserTransaction interface Is used 10 mark the botndaries of
a JTA transaction.

« Code paltern of a distributed transaction under an applicatiion server:
+ J1 Obtain biserTransaction object from the applcation server
¥ InialCenizd chi= new InaiContaxt();
» pvaxtansaction UserTransaction utx = (UserTrarsacton) chuiookuptjavacormplserTransacion ).
¥ Irikse the begin method on & Uisacirarsacton cbiect 10 ndeata
¥ {rtha beginning of a distrbutad Langaction.

b

s & Exatuls soma SOT statsmarnts wih ona Connetlion objest.
» K Do rotcall Conpsatisn methods cormmll o1 rofback.

* o

1 2 Usa tha commil meod on e UserTransacton obiedt 3
¥ f dehve all ransaction banches to commdl and Indicate

} Hike end of the distrbuted ransacton

» ubcommad;

© 2010 IBM Corporation

What is a Transaction?

« Alinanciat program might transier money from a savings account 10 a frading
account by using the pseudocode below:
» begin ransacton
y ool savirgs accoun!
v credi irading account
¥ commit lransscton
« Either afl or nope of the two steps must complete, Otherwise, data integrity is
lsst. Because the steps within a transaction are a unified who'e, a transaction
Is oflen defined as an indivisible unft of work.

» A transaction can end ko two ways:
» with a.commH for a successhl fransaction
¥ with a roliback for a lafied fransaction

o As shown, tha begin and comm? statements mark the boundaries of the
transaction, which is declared by application developer,

Distributed Transaction in JEE

+ Distributed transactions typlcalty involve multiple connections fo the same data
source of different data sources from the same of different manutacturers.

» J2EE supports distdbuted transactions through Java Transaction APY (JTA)
and Java Transaction Sewvice (JTS) specifications,

« JTS Is seldom manipulated direcity by application developers.

« JTA specifies standard Java inlerfaces between a fransaction manager and tha
parties involved in a distributed transaction system: the resource manager, the
application sesver, and the fransactionat applications. For exarnple:

¥ DB2 acls as aresowce Manager.
» WAS assumes the rofe of & binsacTion

« JOBE drivers with distribuled iransaction capabllity are required. For example:

3 ComIbm.0bR b DA Source 61255 Should be used when dafining BB2 data sources
involved in & distributed transaction within the WAS.
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Chapter 3: Step by Step Lab Instructions for WAS-lab

Task A — Setup DB2 Database Tables

I. Right click on the DB2 tray icon on the taskbar and select “DB2 Control Cen-

"

ter

Friable Quick Launth of Contre) Center

Start (DB2)
Stop {DB2ZY

 Launch Tadl at St;artup
Exit

2. A dialogue called “Control Center View” is shown, click “OK” . Then the
Control Center shows. :
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3. On the menu bar, click “Tools — Command Editor” and another Command
Editor window will be shown. Click “Add” button.




4, Select “SAMPLE" fromihe “Specify Target” dialogue box.

| Cance




5. Enter the following SQL statement in the Command Editor and click the
“Run” button, Check to see if “The SQL command completed

successfully.” appears on the status window.

CREATE TABLE A (
NAME VARCHAR(20) NOT NULL,
VALUE INTEGER,
PRIMARY KEY (NAME)

I CREATE TABLE A ¢
: NAME  VARCHAR{20),
VALUE  INTECER

eormect to SAMPLE
Dacabase Connection Information
DPBZ/RY 2.7.0

DBZADMIN
SAUPLE

Datahase server
5L authoxization ID
Local database alias

& IDBC connection to the target has succesded.
——————————————— Coxnands Entered —-—-—-——-—-so-ossnmemnne—o—oo——
| CREATE TABLE & {
HAME VARCHAR{ZC) ,
VALUE ENTRERR

: =TT TIANE  VARLHAR{IZO], ViIOE INTEGER }
{ DBZDDODI The S80I command completed successfully.

|| staterient ternindtiof charectel [; |




6. Enter the following SQL statement in the Command Editor and click the
“Run” button, Check to see if “The SQL command completed

successfully.” appears on the status window.

INSERTINTO A VALUES (‘SAMPLE', 10);

Sommend ey, Selted (IR T
EX Y-S

i | s s

INSERT INTO A VALURS ("SAMPLE®, 10} ;i

target | 3 SAMPLE

TECEIE S U TR T T I T R P TR G T O

Database server PB2/NT 2.7.0

$0QL suthorization ID = DB2EDHIN
Local dacebase alias = SAMPER
& JDBC connaction to the target has succeeded. B
—————————————————————————————— Conmands Entered ————= ————
CREATE TABLE A |
HANE VARCHAR{Z20) ,
VALUE INTEGER
Vi
CREATE TABLE A ( NAME VARCHAR{2C}), VALUE INTEGER }
DEZDOO0I The SQL commend completed successfully. :
——————————— e -—-c 1ds Bntered —-----s-soen - 9
INSERT INTG A VALURE {'SAMPLE', 103; %
5

i G A VALURS ('SRHPLE', 10}
£l DB200DOY The 80QL comwand complevad succes@




7. Close Command Editor by clicking Command Editor — Exit on the menu bar.
In Control Cetner, expand All Databases - SAMPLE — Tables by clicking the
(+) icon in the Object View. On the right panel, the created table A should be
_there. Click to select table A and then click Query link on the bottom.
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8. A Command Editor will be shown again with a SQL statement already there.
Click the Run button.

.............................. Gomnands RILAERE —=---m-bbosbEsiann——————
connaet to SAMPLE 4

ceznict o FARPLE
Daxabars Cesmactien Infermatdes
Patebare serwi¥ = DEZ/ET 2.7.0

29L amcharizatien ID = bEXAbATH 4
Total detanaxe aling & SaNFil

A JBEC comnattivn to the targes hue suzedtdid.




9. The Query Results tab will be shown with the records of table A displayed in a
table. The field values should be consistent with the previous insert SQL state-
ment. Close Command Editor by clicking Command Editor --> Exit on the menu

bar.

10. Using similar steps from 3 to 9 above to prepare another table, called B, in the da-
tabase MF with reference to the following SQL statements.

CREATE TABLE B (
NAME VARCHAR(20) NOT NULL,
VALUE INTEGER,
PRIMARY KEY (NAME)

)’.

INSERT INTO B VALUES ('MF', 20);

- Congratulations, you have finished Task A 01" this lab. Go ahead to Task B.




Task B - Configure Data Sources in WebSphere Application Server .

1. Open FireFox and enter the link ( http:/Alocathost:9060/ibm/console). Log in to the
Integrated Solutions Console. Enter admin as username and admin as password,
click Log in. The Welcome page shows.

2. Click Resources — JDBC — Data sources. Click the New button on the right
panel.
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3. Enter the following details and click Next.

Data source name: SAMPLE
INDI name: jdbe/sample
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4. Select DB2 Universal JDBC Driver Provider (XA) in Select an existing JDBC
provider. Click Next..
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5. Enter the following details and click Next.

ann‘mm*

Driver type: 4

Database name: SAMPLE
Server name: localhost
Port number: 50000
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6. Select the following details and click “Next™.

Authentication alias for XA recovery: sample_login
Component-managed authentication alias: sample_login
Mapping-configuration alias: (none)
Container-managed authentication alias: sample login
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7. Tn Step 5: Summary, click Finish. Then click Save on the top of the screen to
make the setting effective.
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8. Using similar steps from 2 to 6 above to prepare another data source, called MF,

with reference to the following details.

Data source name: MF

JNDI name: jdbe/mf

Driver type: 4

Database name: MF

Server name: localhost

Port number: 50010

Authentication alias for XA recovery: mf_login
Component-managed authentication alias: mf_login
Mapping-configuration alias: (none)
Container-managed authentication alias: mf_login




9. Go back to Data sources page, select MF and SAMPLE and then click the Test
J conmection button.
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Congratulations, you have finished Task B of this lab. Go ahead to Task C.



Task C - Test and Modify Servlet Involving a Distributed Transaction

Use db2admin as username and password as password account log in the Windows
VMware image.

1. Double click on the IBM Rationa! Application Developer icon (RAD) which is
located on desktop

Select a workspace \

Rationak® Application Developer™ for WebSphere® Software stores your projects in a Folder called & workspace.
Choose 4 workspace Folder to use for this session, ' i

IBM Software : S -

Launching, please wait ...

ticagnad Matedal - Propenty of IEM Cotp. S8R Sopenton and others 1987, 2058
I3 pral the 54 dogn 8r¢ tradimalks of IBM Coip. i thie United Stetes, plvr ciunkiss, ot iy




3. Bxpand the WAS-lab-web project -> Java Resources -> sre ->
com.ibm.sqljdemo by clicking (+) in the Enterprise Explorer.
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4. Double click MainframeServlet.java, modification of codes will be done here.

1 F,

o el Erder

+ package tawm, fow, zgijdens:
i SO U VRPN, «. S v VO 3
3% inpert java.io. IOExcaptionifl
¥
iR publiv eiacd FainfrevsServiet exbende EcepServier {
19
20 private static £inal Yong seriaiVersionTID = ik
21,
72 £# vatasoures
FX) private static DataSource wimdogwsdS = null:
4 private stati¢ DataSource maiaframedS v nully
5
ig £# JFA tranascrian
z7 private statio Usericansaction ks = noil;
28
25 . 74 ORDI nmmes to fcfulre DathSource fron applicavich server
k1] private stabio Stcing FTNGONS DS JRGL HAME = ®)dbo/sanple’
3 private stadic Btoing MAZRPRAME DS JHREL MANE = "idvg/ni"y

3 W33 Wassbrprofat
% 128 E.is-tsh-md}

& g Whstabwad
Ehaé svs Rezolrees

- P

S £ web 208 Mavigaticn
L 8 (5 wnblontert

338 pulllit Yoid initi) threws Jeevizvixcepodon
¥4 saper. init{};
35 InitiaiContext ¢ty = nulkl;

37 (552

El:] <tx = new InitislConcext(}:

3% 2/ thtein DateSaurde fvom applisation agrvar

40’ windewsDs = [Patadouree] fox. lookup (WIHDOWS DS JNUT NAME}:

41 . mainfrap:DS » {DatmSource) cux.]aokup(mFiﬁﬁ.E_'DS_JNDI_'M);

43 }/ Chorsin JTA cransoction from gpplication servexn
4% uty = {UperTransaotion) otx.icokup{”javaivenp/UsarTransaction'):

35 } ovateh {Excaption e} ¢
46 . a.printscacklraceid
47 ¥

48 }

49

507 publie HiihframaSzeviet{) {

suyer ()2




5. Right click on the WebSphere Application Server v7.0 at locathost in the
server perspective, select Add and Remove Projects in order to test the project.
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6. Make sure the project WAS-lab-project is in the Configured projects, otherwise,
click Add All to add the project and click Finish

Add and Remove Projects
Modify the projects that are configured on the server

% QO-project
@3- {F was-lab-project




7. Start the WebSphere Application Server instance by right clicking WebSphere
Application Server v7.0 at localhost and selecting Start.

1 packogs oom.ibn, .qijdm:
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8. Check the server status, which should be “State = Started” and “Status = Syn-
chronized” (server start-up time highly depends on the machine power, which
should be within 1-5 minutes)
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9. Open FireFox and navigate for the link (http://locathost:9080/WAS-lab-
web/MainframeServiet) in Bookmarks.
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10. The following sereen should appear, it shows a record of table A in SAMPLE da-
tabase and another record of table B in MF database respectively.
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F] {31 Distributed fransaction Display .
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Distributed Transaction - Display

Running SGL on SAFFLE datcbasai SELECT NAME, VALUE FROM 2




11. On the address bar, enter the link (http://localhost:9080/WAS- lab-
web/MainframeServlet?action=update). It shows the distributed transaction failed.

Dlstrlbuted Tl“lnsactlon Update

Running $G% on SAMPLE davebase: UPDATE A SZT VALUE=9 ©HERE NAEE='nukl*

Running £QL on KF databaset UPDATE B SET VALUE=21 WHERE NANE=‘null'

The result of the distributed transaccion{is failed.

Do s T sl

12. On the address bar, enter the link (hitp://focalhost:9080/WAS-lab-
web/MainframeServlet?action=display). It shows the records in tables A and B

and their values are not changed.

Dlstnbuted Tl'ansactmn })lsplmr

Runniny 8GL on SANFLE datebase: SELECT NAHE, VALUE FROM &

HANE i VALDE

SARPLE




13. On the address bar, enter the link (http://localhost: 9080/ WAS-lab-
web/MainframeSewlet?action=undate&windowsName=SAMPLE). It shows the

distributed transaction failed again.

| buted Transa pda

Yew Hgoy podkmake  Took  Hep
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Distributed Transaction - Update

Running SGL on SANPLE datcbases UPDAIE ) SET VALUE=D WHERE NAWE='SAMPLE*

Running SOL on HF datebaser UPDATE B SET VALUE=21 WHERE MAHE='nuill*

The result of the discribuced transaobion §

DO e e e e

14. On the address bar, enter the link (http:/locathost:0080/WAS-lab-
web/MainframeServlet?action=display). It shows the records in tables A and B

and, again, their values are not changed.

Distributed Transaction - Display

Running SOL on SAXPLE davabaser SELECT WABE, VALUE FROM A

NABE | YALPE

MNAHE




15. On the address bar, enter the link (http:/localhost:9080/WAS-lab-
webMainframeServlet?action=update&mainﬁ'ameName=MF). Tt shows the dis-

tributed transaction failed again.

T K o ([ ek

WINPT
Distributed Transaction - Update

Running QL on SAKPLE darsbaze: UPDATE A SET VALUZ=9 PHERE NAME='null*

Running SOL on HF datebase: UPDATE B SET VALUE=23 VHERE NARE='HF

The result of the distributed tzansaction

R

16. On the address bar, enter the link (http:/localhost:9080/WAS-lab-
web/MainframeServlet?action=display). It shows the records in tables A and B

and, again, their values are not changed.

Running S0L on SAXPLE datebases SELECT RAEE, VMLUE FROM A

MAHME

SLMEPLE




17. On the address bar, enter the link (http://localhost:9080/WAS-lab-

webMainfrarneServlet?acﬁon=undate&mainframeName=MF&windowsName=S

AMPLE). It shows the distributed transaction successful,

i
He £ Vew Agory ookoaks Iok bep

EBE07 ¢ 2 & {3 heioseis i abp
LS B G il
| {onttouted Transastion-vpdste. .- [ 070t

Distributed Transaction - Update

Running 3QL on SAWPLE dstebsse: UPPATE L SET VALUE=® UHERE MEME='SAHPLE'

Punning SOL on BF datehese: UFDATE B SET VALUE=Z1 EHERE NANE~'¥F'

The result of the distributed transactionfis succesaful.

18. On the address bar, enter the link (http://localhost: 9080/ WAS-lab-

web/MainframeServlet?action=display). It shows the records in tables A and B
and their values are changed according to the SQL statements.

&y, @.Rtm[fgca!mjmmmmﬁs_ga
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t Macvkiens L

Distributed Transaction - Display

Tenhing SOL on SARPLE dautebase: SELECT NAME, VALUE TROM A

NAHE LUE

SAEPLE |9

Punning SOL on HF datebase: SELECT NABE, VALUE FRGR B

_______________ [,
HNAHE { VALUE

¥F )
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Source code explanation

The serviet MainframeServlet java generates an html page. Take a look on the source
code in the RAD, the method request.getParameter(“action”) [line 66] get the value of
variable “action” from the URL.

g4t

65
85 -
67

74

public wvoid doService (HttpServiecRequedgt request,
HropherviecResponse response)} throws ServiecException, IOException {

3tring action = raguest.getParxametex {Taction');

if ("display”.equais{action}) {

dobispiayinfo{request, respense};

+ else if {"update’.equals{action}) {

doUpdaceinfo (request, response)’

+ else

doDisplayinfo{request, ICesSPOREE);

If the value of “action” is equal to “display”, it calls the method doDisplayinfo
value of “action” isequalto “update” , it calls doUpdatelnfo.

i package con.ibm.sqglidemo:

2

i

3@::&9.90:1: java.io.10Exception:i]

171

ie
19

i:ublic class HainfrareServiet extends HucpServiet {

+
.

25 i
21 :
2z |
73
24
25
26 !
27 ¢

28 !
3t

H

i
i

30 |

31
32

536

3%

I
i
t

H

35 °
3g -
37 |
38 ¢
39 .
a0,
4%
§2

43
kL

45
45 |

47

private

static final long serialVersionDIP = iE;

/7 DataSoures

private
private

static DatalBource vindowsDS = nmli;
statio DataScurce mainfremePS = noll;

/7 JTIA tranzaction

privata

£F Jani
private
private

static UserTranssction uha = wall}

names to Ecguire DataSource from spplicatien sesver
static String WINDOFS DS JNRI NAME = widbo/ sanpie¥;
static String MAINFRAME DS JRDI_HAME = "jdbo/miv:

peblia veid ipic{} throws ServietExcepcion {
supar.init(};
IaiciglContext oty = noll;

try

£

ctx = new InivialiContext(}:

/7 Totain DataSeurce from aprlicacion ssryver

vindovsDs = {DataSource) Ctx.lookup{TFINDONS DS JNDI RAME);
mainframeDd = {DataSoures) Ctx.Xookup(MAINFRAME DS JRPI RAME):

/f Dbtain JTA txansaction Ifrom application server
ntx = [UserTransacticn} ctx.lookup("java:comp/Userfransastion™)?

} catoh {Exceprtion &) {

H

e,princStackIrace ()7

Lines 23 to 24 declare the DataSource objects.

VI tha

Line 27 declare the JTA transaction object that is used to manipulate the transaction pro-
grammatically.



Lines 30 and 31 are the JNDI names configured in the WAS data sources.

Lines 40 to 44 is the program code to obtain DataSource objects and JTA transaction ob-
ject from the application server.

Line 76 shows the method doDisplayInfo that is to generate the html page to display the
records of tables A and B respectively.

16-"" pehlic void doDisplayInfa {HrupSexvietRequest yeguest,
it 2 HotpServiecResponse response) throws ServietException, ICException {
FE ServietCuatputfcresm o3 = response.gecdutputScrean() ;

/7 5QL stenemsnt to be execuved on SAMPLE datebsse L0 reLLIR Yscords
String wikdowsSQL = "SELECT MAME, VALUE FROM A"

/7 345 statement to be exscuted on HE databage té rerurn records
string mainframeSQL = PSELECT MAME, WALGE FROY BM;

try §
/f Sar connections Irom application server
Connection windowsCenh = windowsDS.gecConnection(})?
Connecticn mainframeConn = msinframeD§.getConnecticn(}:

as.print ("<htmlr<head><bitle>Distyibuted Trarsaction - Display</ticie»</head>"};
as. print{T<body>")s
os,.println{"<hl>Digtributed Transaction — Display</hi>F)}

7/ Creste pratementa in connections
Statement windowsStnt = windowsConn.cresteStavement ()
Statement mainframeStmt = mainframefonn.createStavementi});

/f Ewecute SOL statementa and get racerds

10G Reauibget windowsRs: = windowsStmt,executeQuery (windows3QL);

161 Resuicies mainframeRa = mainframeScmt, execureQuery (EainframeSRh) ;
igz

193 | gg,printin{<pre>T};

104 ! o8,printin{®Running SQL on SEHEBLE dstabaseal " 3 windowsSQL):

10% l os.printin{);

106 | 08 . printin{f-———em—m—————e Fm e — "z

197 T oa.println{"HAME } VALUE "y

0B : 08, PrAntn [T-~—m—m = Frmmmmmmem—mm "y

LY A5t e Faefem Seeem¥io — s 21 Y

Lines 81 to 84 define the select SQL statements to be execute to get the records from ta-
bles A and B respectively.

Lines 88 and 89 are to get DataSource Connection objects from the application server.
Lines 96 and 97 create the JDBC Statement objects to be executed.

Lines 100 and 101 are to execute the SQL statements and return the records to the Re-
sultSet objects.




ig2

f! ’ 103 cz.princln{"<pre>iy;
f 184 os.princin("Ranning 3L on SEHPLE datekazer * 4+ windowaSQL):
) 165 a5, printin(}:
108 ag,printin{m---- ——re ———=f}2
P 197 o2.prinTln {THAME } VALUE R
| 108 g8, printlni” - -—4- - -y
1 108 while (window3aBs.nextlj) {
21D . Qs.prim:(windowsxa.getsr,xing("HJ&%“H;
4311 i os.print (* [ T I
] 122 | o, princin (windowsRs.gavIne ("VATUEM} )
‘ 143 H
114 08.printin{T-- fromm e "y:
115 os,printlni}?
[ 146} as.printini"Runmng 3QL on MF database: T 3 rainframeSQLY
! A1n o3.printin}; B
_‘ LS 1B s#.println{"-——em=m—mmre— e — e Ty
139 - os.printin {"HAHE { VALUE Ry
129 OB PEADCIR (Mmoo Frmm— e "}
121 while (mainframeRs.next{}) {
122 3 os.princ {mainfremeRs. gecString (“HAME") ) ;
323 og.princ (" S
124 cs.printin{painframeRs.getint {"VALUE ) };
; 128 | }
i 126 | os.printin(™ - Fr——m—— s Ty
127 o8.printin (NCfpredy);
126 az.pzint {"</body></Rumi>r);
129 ¢ es.cloae(}?
| 130 | ’ . g *
[ 135 #/ Release resources
132 | painframeStmt.oloaa {}?
133 ! windowsStmt.close{}:
134 ! mainframeConn.cleas(};
} 135 | windowsConn.clase () ;

Lines 109 to 113 are a loop body to iterate the ResultSet returned from the SAMPLE da-
| ' tabase to display the record values on the HTML page. Lines 121 to 125 function the
' same but for the MF database.
| Lines 132 to 135 release the resources back to the application server.

Line 143 is the method doUpdatelnfo that is to perform a distributed transaction involv-
=\ ing databases SAMPLE and MF.



3455 public wvoid dolpdateiafo (Ftrpferviecieguest rageest,

144 HotpSeyvietResponss response} throws ServiecException, ICExXcepticn H
148 ServletOatpucicresan 03 = ragponze.gecOusputitreanty

144 |

147 // Reguest paramecexa from URL

248 String windowstame = :eques\:.getfaramecer("winﬁawsﬁame"};

143 Enring mainiyamailane = :equeat.ge:?arameter(“m&znframeuame");

180

154 /7 Flag indicacing the vesuit of disctribuzed cranssction

1E2 boolean success = false;

X Ea

153

154 /7 50T scmuEmAnts Lo update the reapective teble in SRHPLE 2nd MF datzhasag
155 String windowsSQL = “UPDRTE A BEY VALOE~S WHERE MRME='" 3+ windowstame + "'
136 - gtying mainirameSQL = "UPDATE B3 SET VALUE=21 WHERE HAMF='" : mainfzameName + "'%;
157, .

358 try {

1E8 C /7 Mark distributed transacticn begin

180 yix.begini)

161

162 | /7 eet connections from applicztion servwer

163 ¢ Connection windowsCenn = vindovsDS.gesConnectioni)?

164 | Connecclon mainfremxaConn = meinfranal§. gstlonnection{i;

165 . )

186 * /7 Create sScatemsnts in CORREBCLIORS

167 f Statement windowsitnt = windowaConn.createStatanenti) }

168 ¢ featement mainlramedtEt = mainframelonn,createltatenant [}

igs !

170 7/ Execure SQL statements and get updated count

171 int windowsCount = windowsStmo.erecutelpdace {windowa3QL) ;

172 int mainframeCount = nmainfremeStmi.executalpdate trainframesQL) ;

i73 !

174 // Busineas logic o decermine Tyanasction succazsivl or not

175 ; Iz windowsCount == 3 e=an3 updsting SRMPLE databaze succesaiully
176 0 ir mainframeCount == 1 mezas updating NF dacabase soccessfully

Lines 148 and 149 are to get the parameters from the URL which will be passed to the
SQL statements for execution.

Lines 155 and 156 are the update SQL statements to modify record value of table A in
the SAMPLE database and that of table B in the MF database.

Line 160 is to mark the start of the distributed transaction boundary.

Lines 171 and 172 are the actual execution of the update SQL statements. The method
executeUpdate returns the number of records affected after the SQL statement is exe-
cuted. Tn our sample tables, each should have only one record and therefore the number
of records affected in a successful case is one.

e

i

—
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193

g
Lerd
wm

_os.princin{"<fprexty;

I if updacing both datsbhazes auccaessfully, comit phe trapsaccion:
i sthergise rpllbagk =ha tranzaction
1f {(windeowsCount = 1) && (mainfremsfount == 1}} £
#Ex.commit()
suecess = tros)
} else {
by rollibacki}?
sugeess = false;
H

/¢ Relmase resonrses
mainframestme. close s
windowsStmo . ciose(}?
mainfrsmeConn.cloge{);?
windowsCenn.close(}?
j aateh {SQLExcepticn se) {
System.out, printin (*SQLExceptiont? + se.toString{}):
} catch (Exception ej {
System.out.prinsin (*Exception:” % e.coduring{}):
H

oa.pxint("<h;ml><haad><ait1é>niabributed Transaction - Update</title></heads"};
0s5.pring ("<body>¥);
os.printin("<hid>Distributed Tranzaction - UpdateCfRix"}:
og.println{t<pred>™};
os.priotin{Rusning 53QL on SEMPLE datsbase: 7 & windowsSQL)
os.printin{};
o3.princin{Running 39L on MF datsabase: A 4+ madnframeSQLY ;
os.printin{}s
if {success}
on.printin{"The result of the discributed trxansaction is successful.v);
else
qs.princlin(®The result of the distributed transaction is failed.¥);

a e e — emme ot e T B et g

Lines 179 to 185 are the business logic to determine if the distributed fransaction should
be committed or rolled back. If both numbers of record affected of the tables meet the all
the required success conditions, the distributed transaction will be committed by calling
utx.commit() method; otherwise utx.rollback() will be called to cancel all changes made
within the transaction boundaries.



19. Open MainframeServlet.java in the RAD if you have not done so.

1 & 29 towed
Gl 23 Was-sbproject
@ B3 wastsbweb

B Gy wastabweb

;

20. Now modify the program code to change back to the original record values,

!
'
B S Jvatept Supfiort
L% Secury Edtor

i+ {3 Web Ste Havigstion
B-{5 webConitert

Modify the line 153 to

String windowsSQL = “UPDATE A SET VALUE=10 WHERE
NAME='""+ windowsName + “";

Modify the line 156 to

String mainframeSQL = "“UPDATE B SET VALUE=20 WHERE
l'q rr

NAME='"+ mainframeName + ;

DLE LY wilFuauwsanms LEQUESL, guurﬂtmuun ;"wxu-.muaﬂmw::"f F
Sering mainfraneNawe © Fequest.gscParesscer{mainframetlasat)

77 Flag indicating the result of distributed cransaccion
hoolesn succsss & false)

f.y {

F/ Hardk distriputed transastion begin
by negind)s

74 Gev, conneptions from applicacion server
Connection windowsConn = windowsDS.getComection(j!
Connection mainframsdonn @ myinfranddS.getdonneseion{)!

74 Cresrve ststements in commections
Scatement vindowsStmt % pindowsConn,ecreatedtatsmenti];
Statement watnfrapademt = mainfraresConn, createltatement {):

——rm,



21. Save the file and select Project -> Build All to compile the code and commit the
changes on the WebSphere Application Server.

& P odprajedt Build Working Set s .
; %mwb Cean.. RS (HetpServiethequest peg
oo WhSHeh-project Bistd Ardoeaticaly fspanse responge} thidws San
| s T e

&5 Javs fesounces Propartias rers fram GRL
| Bt R PR R T T IY = paquest,astPavenater (v

b @3- canbdosgidems String mainfremeName = request.getParamater{’

5[ Moot fivs. .
/7 ¥lay iodicating the rasult of discyribured

_q% VWeb Dlagram hofflear success = falge;
H-mh JavaSerpt Support

Loy Seeuiy Edter /7 B0l statewents to updats che respestiva b
L E3 web ore Madgatiea String vindovsSOL = YUPDATE & SET VALUL=ID W
@ (5 WehContent String mainframe8ol = HUEDATE B 2ET VALUE~20

Lew |
/7 ¥ark distributed cranseccion begin

wte.beyini}s

/} Get connoctions from mpplication serwn
tonnegtion windowsfonn = windowsdS.gebliu
Contiestion mainfrapelonn = maiefranedS.q

f7 Cysate statements in sonnestions



22. Open FireFox and enter the link (http://localhost: 9080/ WAS-lab-

web/MainframeSeret?actimFupdate&mainﬂ'ameName=MF&windowsName:S
AMPLE). It shows the distributed transaction successful.

N masmiymsonposer - FEEEE
Distributed Transaction - Display

Running SQL on SAHPLE databasze: SELECT NANE, VALUE FROM A

HAHE

SAMPLE

Running SOL on AF dacabaze: SILECT NAHEI, VALUL TRON B

_______________ fmmm e ———
NAHE 1 L'UE

23. Now revert the program code to change back to the SQL statements as follows.
Then save the file and select Project — Build Al If you are not sure, please re-
fer to step 21 above. CAUTION! DO NOT RUN THE SERVLET IN FIRE-
FOX AGAIN. This step is mandatory for the lab exercise of Chapter 5 - Access
Mainframe DB2 from WebSphere.

Modify the line 155 to
Siring windowsSQL = “UPDATE A SET VALUE=9 WHERE NAME=""

+ windowsName + 7 ;

Modify the line 156 to
String mainframeSQL = “UPDATE B SET VALUE=2] WHERE
NAME=""+ mainframeName + "~ ;

Congratulations, you have finished Task C of this lab. This is the end of the lab.



Suplplementary Sheet for Chapter 3 — Task B

Before executing Step 1 of Task B, please start RAD and WebSphere Application Server.

1. Double click on the TBM Rational Application Developer icon (RAD) which is
located on desktop

2. Click OK to accept the defanlt workspace location

@ ( a 5 <

Select a workspace
Ratluna!@ Bpplication Developer™ fdr WebSphere® Saftware stores your projects in a folder called a workspace,
Choose a workspace folder ko use for Ehls session,

IBN Software

Launching, please wait ...

Wratnesd intedals - Proporty cfiﬁm Cuip. 1M Coporalion axd otherd 1937, 2008
. BM mdi i SR Iy arn etk of BM Cotp i m Brﬁ&ﬁ States, pdw shuniies, &t B




3. Start the WebSphere Application Server instance by right clicking WebSphere
Application Server v7.0 at Iocalhost and selecting Start.

i
;_, ‘ 1 packbyd e ibe,sqiiduis:
- 4
< 3®ingort java,is, J0Exesptienil
s [ ¥4
i6 pubiio tiage Baintreseservier sutends HutpTerviet |
- 19
?%mﬁ‘mm - ;ii! private static finsk long seriadVersdoxiIn = ths
o
H egmhsmm 12 77 batassoree
H i =W mwm s 3 privals static DateSource windissPS = nuil!
: B O aemesanint 34 private static DataSource mripfrasel¥ = nuli:
B el Earan 25
°§ﬁ$;':. 2E s J1) wrsusECTion
: =h wvasapt Supont A private atatic UserTransaction stx = moll:
& - 1
i %mjﬂw _— 3 J¢ JNPY newmes to poguive Patmlpsrce fras agpiiFation server
& o waoaert = 30 private static String ¥IBDONS DS JHDI NAME = *idbr/saspiec:
private static Stoiny MAINFRAKE 55 JFOL B 0 - I
public void init{) throws ServictExeeptiq xm r
super,infeid s
InitiakContaxt gux = mills 2 Copy
{8 vaste
3
v B Dalele

gt% = new InirigiGententl) s
£f Groin bnagonICe frem wpplicd |
: wiadonsDs = (DavsSourcs) otx. 160k
B T4, miinfraxeds - {hatadourte) oex

/{ Gstain &TR crausactina from & ﬁ afis >
otx = |(GserTranzecticn] oty lookd B = TIPS o

} ecatch [Exception s} B publ: {HHAAE
2. princScankTrace{)s LN,
} — [—
3 Bhy A4t ored Ratrvs B Jbett.
Mordortd b

public Fainfres=fezvizti} X
super [}

] creaetabies ard datasourcas
Femdmwust el manisy

4. Check the server status, which should be “State = Started” and “Status = Syn-
chronized” (server start-up time highly depends on the machine power, which

should be within 1-5 minutes)

T R P LR s S D R S b

You may now go back to follow Step 1 of Task B to continue the lab.

———
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aed Shirs, Web Senioes, Manags Saarch, Web Cenlerd tiraies, Syndeation, Vatal Potdd
MBI, Ll

-

Cellaboration: kots Inslant Messaging Centact List, Wi ks Hete, Pecple Finder,
Aty Team Wodkplaces, Web Conferencing, Domina Web Lecss, Domine Pocumsent
Manager, NetesView, Notes Mel, Cafendar, Tasks, ToDy, Distustion, Teameou
Uity Pastate: Login, B Aboud e Poctal,
Diraclory Scarch, Semwte.hsmlﬁasmm
Search: Docurnant Szatch, Seacth Conter, Supgested Links
Ceatant kntegration: Web Centent Mysaqeﬂeni, Produstivity

Ceenponzls, converans and

» Business Process Filzgeaton: Mﬂaﬂsammeu portists
Samglz Porfet

Bagke, Sy v portets

tha ek of I Wt SohaTE zJ MG 1 -Wetborws Purie! berodudion

TTechWorks %
Putting Pages, Apphcat:ons & Other Content into Portal

1. Dlsp!ay Exisimg HIMLAED Apps
Vieb Clpping., Web Appication Indgrates

2. Inslal} Existing Porlfels Oul-ol the-
ox or Irom the Portiet Catalog

GrealSrJem. e [ aomdiap

3. Use HTML 1o0ls [*swuc Pages”)
Build HTMLCSS mift HTIAL edilor, Add pmses.
vk, Instadd -
4 Lo!us Web Content Management
5 cordent, Fmﬁamwa Conent
hlewzta Droc Librarps®
5. Usé Bulli-In Web 2.0 Serviees* -
Semanie 1, Tn_;_;, ﬁmmse
aweoahm.
6. 1noorpora'le Co!laboration
n.uxm bstant bsg, Tear spaces, et

9, Davelop Custom Portlets

Pwetrmaﬁvé 1D, {laa™, ISP, Web
gﬂml(.é%‘} -
", P i 308 = s e

stte
usiness

" Bulld Com
eFom\a &

Fcat! ons,
TOCeSses -

* Vaue Proposition of a Podal
+ Whatls a Portai?

[o WebSphete Portal V7.0 Architecture . ]

» Methods to quickly populate your Portal with existing content and applications
» Feeds
¥ Statio HTML
+ Dynamic web appleations

» WebSphere Portal delivars Exceplional Moblle Exparience

Go 1o 'View > Header and Footer' to change this fo match the event title
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[Tecnwors _

WebSphere Portal Productlon Archtte'c-:tﬁ.ré

Collaboration Tier

Vel syt

LAY at‘,' A
; i ih

)': - f{"r‘( -

| TeshWorks
WebSphere Portal Main Components

IBM HTTP
Server

Also¥S, ol

WebSphere
Portist Factory

Derby
{database)

Also DB2, Oracle, SOL Server

Works with your Environment

» Platforms LEE
¥ AIX®, I/OS®, RHEL and SLES Linux® (Ineld, pSeriesd, 280resd), | RS e
ZOS® {native)", Sciaris™ and Windows® ;@'m
+ Databases
» 15 D223, Dracke®, SOL Serverd, Derby {C) (Ctmdsmpw)
& Directosies
» Microsolt® Active Direstory, Novell® eDtero:y. Sua™, Domine, (M Dizestory
Server, Custom User Reptsty
* Extemal Securﬁy Manger
* Tivoli® Access Manager, SiteMinder
« HTTP Web Servers Y\
» 1B#, Apache, Microsoft, Sun

&4 80 by platfotan

» Browsers
¥ Microsoft intemet Explorer, Firelox®

l)“

[ TechWorks ==

Portlet Perspective

» To an End User: a portlst i a window fo display their preferred content

» To a Content Provider: a means for largeting content to the end user.

« Poital Adminkstrator; a WAR lile

« Porlal Server: a component rendered and aggregated info ene of iis pages
» Developer: a Java appBealion whose fifecycle is managad by the container

pcove g The vale of [BM WebSehea Poaxd 46 & - WebSohan Podal Iniiodudion

Go to 'View > Header and Footer' to change this to match the event title
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L |TeshWers - L

Porilet Standards

» Java™ Specificalion Request (JSR) 286 — Java Portiel
Specification V2.0
3 1BM ks Jeading this 58, 2% major Java technology portal
{commergial and cpen source) vendals represented
b Approved: March O4th 2008 (WebSia complate April &h}
« Web Sewices Tor Remote Porels (NSRP} V2.0
b Standard protonol for accessing pedieis as web senvice
+ Defined a5 CASIS, chaired by IBM, Approved: March st
2003
» Commaon goals
+ Enabls coordination between porlieis and aliow buiding
compost s applications based on pordlel components (evanis
and randes contet [a.g. pubiic rendss paramelers) )
» WebSphere Porlal seamiessly infegrates JSR168,
JSR286 and WSRP 2.0 Polels.
» Alsointegrales IBM Porfiet AP) and WSRP 1.0

S e g

Biscovcng P vk of BU WeSshard Part vst W'E?“

| FechWorks

Various Methods to Display Portal Content

« Provide iinks o existing content”

« Display exisling static pages*

» Include dynamic web applications®
» Loverage fesd sources®

# Buiid cuslom porilels

« Supplied email and Eolus porilels

s Download vendor portiets from
IBM® Porllal Catalog®

» Render Web Services {or Remole
Portlets {(WSRP)*

» Web Content Manager
o Others?

* We will cover these during ihis
presentation

» Value Peoposition of a Porial
+ Whatis a Portal?
* WebSphere Postal V7.0 Architeclure

« Methods to quickly populate your Portal with axismg content and apptical%ons
» Feeds
» Static HTML
3 Dynamic web appleations

» WebSphere Porlal detvars Exceplionat Waohile Expenence

[Fesons ]
Quickly Poputate your Portal

« Value of WebSphere Portal
» Onidcidy and easdy sonsalidate axisting content and applications

* WabSphare Portal V6.1 includes numarcus out-of-ithe-box fealures

« Wo will highlight the followlng:
+ Really Simpla Syndication {R5S) Feeds
» Bookmarks and Links
+ Google Gadgels
» Static Web Pages
b Web Applicafion Integrator
¥ Portal Calalog
¥ Web Senvices for Remote Portels (WSRP}

Go to 'View > Header and Footer' o change this to match the event title
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o Jvechworks
Feed Reader Portlet

et Byd ead Pemel

« Supplied cut-oi-the-box
« Supporis ATOM and RSS

St .

FEIETTE g I A At saa‘ﬂ 4-3 15 riga 25} et

Feed settings

Feed URL:

Fne-'d naral 5
T

Feed descriplion:
Dopg prgvss Tols &2 Frante o2 {AF)
3 erazte da O KA

Murber of fsed eniries prr page:

4 Byavmssocsta

v Bsnow wrartied eits

¢ Bl o o lesd it

» Elmuwntsdraeh o oeatd

semasts

renicd ). 8w P

MTwlse S FE
§ £, T8 TERN 1oAY, ey ook T ws b oy R0 d e
T LB BT 505 T80 B3 L7 Winthes et

About this feed

T3 srrnina e
S 1O R P S

} TechWorks
Google Gadgets

« Place any Google gadget on a page )
« Dowinload the 1BM Porliel for Google Gadgels™ from the Poral catalog
. Seamless mteg!aﬂon wnh 1housands of web based sduﬁons

Bifars lorvelbdmdde | barfog M SIAIY RARe W O WAw B

; The tong goodbye: AL wins Ait-Star game 43 in 15

? By BOAATS ELoSA AF Bryebad feie E
=Ty SHeos, B _

 HETER oF - {herrandoad atebor be f be cerhing 338 CRE
¥ Horsm eondsd i Eres Ve 3ot oy v petss

; Bzt L 158 g 57 1 BOK APt 48 VIR SN0 3 P

trFpars per el Js pocined 59 Hrxwb g g e

#

Furds i

i

o [ TechWorks
Lmks and Bookmarks

» New Web 2.0 Bockmarks Porllet

» Supplied out-of-the-box

» Web 2.0 user Inlarface makes R fast and easy to usel

» Can baokmark extemal URLs and intemal Porlal pages

3

[ TechWods o
Web Application lntegrator

» Cantralizes access 1o external web applications within the enterprise

» Integration of web applications occurs by injecting Porlal navigation into
extemal web applications themselves

» No portlet development required
» Does NOT use an IFrame element

« Portal markup ks “injected” Into an external web application by adding an
HTML <script> tag fo the web app

# Ussr befieves he/she Is still within the Portal environment
¥ in reality, u}ey are nalively browsing the external wab application

« The integrated web application can use any lechnelogy (e.g. NET, Ruby on
Rails™, PHP, PEARL, Domino®, J2EE, ale.}

« Download this porilet from IBM Portal catalog

" Go 1o 'View > Header and Footer' to change this fo match the event title
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[TecWote — .=

Wéb Apphca’elon"lntegrator

Three sasy sieps:
1} Creals a standard Postal URL pags, specllying the URL to the extemal web
appication
2} Use the new WebAppinfegralor podiel lo generale an HTHL <seript> lag for
yourweb application
3) Add th scriptiag to the header component of the web applisation. Forsome
themes, tha seript tag must also be added lo the Tooler component,

<!-- EEGIN PORTAL RAVIGATION INTESRATION -->

<sczipt typesTtert/javascript
£rcsthttpr//192.168.123,107:10040/wps/myportal s Iut/psc5 /04 SRIRORLLMINSS:E
yBxBxv_LUIHeCAS-

BRET00S5S_COVAICR_ YIOPNUADGIELa 1 /2 Portad_FPage ID<6_CGAHATLOOOYIFO2REBISIS
007t P
<Jscript>

<i-- END PORTAL KAVIGATION INTEGPATION -->

[Teomwions e

E@tic Web Page Integration

« Allows webmasters to publish web pages directly inlo Poriak
» SimpYfies creation of portal pages
+ Creals smart HTML pages using live toxd in WebSphere Pontal
» Conlrast 10 web clipping

¥ Not g "gef” from aremote sife

¥ Usa favorite HIML desipn tools and publish to WebSphare Porlal

» Remove HTIAL <head> secbon before pubishing

* Aligws Portal o display properly Insida &'s own HTML

tohtea )
5 ot
Lhs tevirrg e vake of L1

2 Porial W1 mﬁ:‘dmﬂ»’m

. |TechWods
Web Application Integrator

—

= After Winjection”, the web

application works both inside
and oudside the Pordal

Static Web Page Integration

. Crealeh Adobe@ Breamweaver® » Vigwinsida WebSphere Portal

hu‘\n come b1 ate el ptare ﬁr-"ﬂnum;ylls ud' t-fsuvehhn
Mmtsmmmmwnmpﬂmma - :

H Eq'u-cﬁl .

1 1o et s oty 3
Prlr T ant g e e

HE L LT &

!
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 |TechWoks
Agenda

« Valze Proposition of a Portal
« What Is a Porlal?
» \WebSphere Porial V7.0 Architeclure

« Mathods 1o quickly populate your Porfal with existing content aad applications

3 Feeds
» Stafic HTML
* Dymmhweb appfeations

-

[- WebSphere Portal delivers Exceptional Mobile Exparlence _]

J TechWorks

To create mobile applications that:

Including web content management

Are personalized {o a user's role,
prefarences, and behavior

. Support end-user customization

. Are secure

Can be measured and optimized
using analytics

Can adapt thelr presentation and
functionality according to the davice

Why Leverage a Porfal Framework for Mobile Solution Deiwary?

. Integrate with your back-end systems,

Onea common framewori fof moblfe &
web applications

Techmques for Creatmg Except:onai tviobﬁe Experiences

 {TechWorks

Browser Based, Web Applications
Accessiblie over lhe Infemet without need to
downioad software

Uses device browser to tisplay content

Hybrid 7 Both Web and Native Components
Native lookdng appications which uiliza the

browser interface fo defiver canlent

Prowide the abiiity 10 use native device features

vithoul witing code for each device

Nathve
Meiomakeusen!mmesnawuealwes such
as camera, GPS, sotelerometer, calendar, elo..
Supports the riches| of user expadences {8.g.,

gaming agplications)

| TecnWworks
Webs EPhere Portal Themes for Smartphones

Extend Portal web exporience to
mobile devices though the use of Poral
themes for smariphones

Qpfimizas kook & feet for smaller screans {site
randing, navigation, page layoul}

Cpimies page dumn!oad size for mobie
connections -

Create natlve—looking smartphone
Portal themes using famifiar technologles
and skillsets (HTML, CSS, Javascript)

Two moblile theme options provided:
- Dedicatet moblle themas can sane dedlca!ed
mobie pages and content
~Single thame can detect the device and LY
mobile presentadon or full site and conlent

Sample themes can be downloaded on
Portal Solutions catalog :
S Prars B otk 2

"o to 'View > Header and Footer' to change this to match the event title
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| TechWorks

WebSphere Portlet Factory for Smart Phones

Automate the creatlon of smariphone-optimized
applications, efimlnating coding and speeding time to market

Support your multh-channe] strategy. Create once and run
on muitipla davices and in multipls formats:

Mobfle-optimlzed applications iPhons, Blackbedry, Androld, Pad)
Porllets of widgets (WebSphete Poral}
\Web application (WebSphere Apphication Server)

Quickly integralé your back-end systems inlo your molde
applications with & 1ebust set of connectors (SAP, Doming,
refalional DB, wet/REST services, PeopleSolt, Slebef, and
more)

Creato native-looking smartphone applfcations using
familiar technologies and skillsels (HFML, G55, Javascripl)

Leveraga the smariphone appllcation samples to speed
development and leam bes! practica technlques, Inchuding bow
10 best support geolocation and phones' orentation features

.| TechWoks

Mobile Portal Accelerator

WebSphere Portal exlension that delivers online content
and applications to virtually all mobile devices,

Adapt your content to over 7,200 mobile devices, MPA
provides infeligent Mutil-Channel Server capabfities that
dymamically renders content to spectiic device charactesdstics
and capabilfiies.

Speed your development with Mobile Portal Toolkitwhich
enables both the development and testing of XDIME {XHTML

wilh Device Independent Marap Extensions)y portlets in IBM
Ratlonal Application Developer.

Keep pace with iha latest moblle devices wilth 1M Moblie
Portal Accelerator Davice Update. Provides regular updates
fo moblle device definfiions as thay become avalable from
device mandacturers.

5 PCsand
=7 Full Browsers

e E3EE

Devices ﬁg!a g

Dynamicaty

O
Muli Channgt & Tendes

Sarver 7,200 Devices

[FechWoiks |

Presentation summary

& You should now be abls to:
¥ Describe the business value of WebSphere Porlal
+ Explaln haw companies ate using WebSphere Porial
¥ Review how 1BM uses WebSphera Portal
} Explaln the basic concepls of a portal
» Igantity the benofits of i8I Fodal to IT and the business vsers
¥ Explain the value ot Web 2.0
» Describa how Web 2.01s incorporated into WebSphere Porlat
+ Identify easy malhods 1o quickly populata your Portal with existing content and apphcations
¥ Use out-of-the-hox WebSphere Portat features
» m how WebSphere Portat defivers exceptionat web experience lo different end

Go to 'View > Header and Footer' {o change this to match the event title
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' ITﬂwm e
Reference materials
+ WebSphere Portal Wikk

» 10 s

¢ Porlal Zons on developeriWorks

v A 17B R 5

+ Portat Business Solutlons Catatog

» b 3o Jolrs comfmpslpod alineca)

+ WebSphese Portal Product Information
» ey 306 dan. coenisen P—

» VWsbSphers Portal information Center
1

» Seld-Help Cendrat Tor Forlal
b Preebaf i men 21200809

« Migrailon Central for Portal and Web Confent Management
» 4 fom T

+ IBM Softwirs Evenis

) ", . i

O Ompy gt MM Ewtponion 2000, A ght raan sl
¥ % 54 o Wit worardy of ary bed wmacd i bpind. ] shal nr 4 wporsky

T Imiteith [ poeL L3

ot ary gk i A ! Fasa ravesh hokay iried i 4% Bttt | reanded | ehal by the w3 ol O ety o

SR R SR e e R e A
EEE 5 ET

P e e e e S

e 0o 172 oo Dl 3 3 4 8 el o i il 4 8 K Sy Sy 2

2rd ol T pandhacts ind seriviiad ik Idenocty o e inhrstoral B uines Machieay Coboiin
B e rm e Bl WLk ey 4 TSttt s Pt o s

5
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Chapter 4: IBM WebSphere Porial

Overview

In this fab, you will integrate existing web content into your new [BM® WebSphere® Portal. This shows
you how easily and quickly you can consolidate existing content into your Portal. You will also configure
the portlets and modify your web content source to achieve communication between portlets.

« Web Page Portlet — configure and display existing web content
When finished, you will see a portlet for each exercise, and the specified content displayed inside each
portlet.

Requirements

Image Requirements:
This lab exercise uses the Portal v7.0 image.

Hardware Requirements:
PC Hardware with a minimum of 3 gigabytes of RAM and 40 gigabytes of free disk space.

Software Requirements:
VMware Workstation version 6

Create a New Serviet
Import a project into RAD

__1.  Open Rational Application Developer (RAD) and start WebSphere Application Server (WAS) if
you have not done so.

__2. On the left sidebar of RAD, right-click and select Import and Import....

'y A WeDSte Hangston
;B SQLIANSHots

Iy

T *f

@ [ WebContenk private statip final dong serialVersionlId = 1L;
%wﬁ} Bt private static DataSource ds = null;
8 3 washbwsh :
Faid
e e — * gsee ja‘vex.sen’leb‘Generic&:vlez_ﬂvoid {}
M'Vf * L74
showln Atashrease ¥ | publie vold init{) throws Serviectkxception {
- super. initihz
LER <all InitialContexs ctx = nall:
Heshtable parms = new Haghtable(}:
Ty porme, put |

Context, INZTIAL, CONTEXT FACTORY,
_.. "cow. ibm,vebgphere, nening. ¥aniniciaifont
intext . PROVIDER URL; Piicpif//n}:

&Y Reffesh i £, £ MR Fla

F] 00900052 ResourceMgrim I

fir1sa &, weR e f1 D0ODOOSZ ResourcelMgeIm I WSVROO:
] 000DDOSZ ResourceMyrln I YSVROOD¢
[124/45 ] GOODGDSZ webapp I com.ibm.1
'3[1!4!11 -20:27:341461 C5T) GOODODSZ WASSessionCor I SessionCe
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3. Setect Project Interchange. Click Next.

Select

Irpork & project and s depmdent profects from a Zip fie,

R
B (S (Y5
H-{2r E38
& & JavaEE
B3> Plugn Davebpment

Tt P
r%nﬂp -
'§ G

web. Then click Finish.

In‘ipi:lrt Prajects
Import Projects from a 2ip file.

5.  You will see Q00-project and Q00-web on the left sidebar.

CiiDocuments and Settingsidbza&minibasktopiQ?iJ @ i E
it — =

I
IBM Techiforks

4.  Click Browse... and select Q00.zip on Desktop. Select both boxes of Q00-project and Q00-

Lab 2 - Leveraging Existing Assets

Page 23
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@ %’5 QDG-project
99 24 qon-web
3}3» QO0-project
g;»:; QD-web
& &1 Deployment Descriptor: sqliDemoWebt

B

__6.  Goto Servers at the bottom of RAD and right-click WebSphere Application Server v7.0 at
localhost. Then select Add and Remove Projects....

- HUNLIG PUAL AHAY 1} WMAUNE UL Y ALULALL VLTS B [EE—
: super.init{); : ) €3 Restart CulalR
i InitialContext ctx = null; §5° Restart in Profile R o
H Hashtable parms = new Hashtablef): & Stop . Cultakis
; parms, put { . :
! ' ERpublch QredkP

Contexc.INITZAL CONTEXT FACTORY,
"com, ibm. yebsbhere, naming ¥shInicidlContextFactory™y
parms, put (Context, PROVIDER URL, “iiopi///7}:

ey ( . ‘ ‘ Morkaog,
! oty = new Initialconbext(parms), ’ E}creatatob{esmddatamges
i dy = tjnvax sql Dﬁ.‘tesnurce) ctx..‘lnbk‘upt"jdbc]squ test‘."l, pwr&,;;cv?‘,gpp,n_gy o
LUrd tfest cherk

Properties . Al:’-l-En]:& .

@A WAS-Iab-p(n}ect B. started Synchronized

7. Select Q00-project and click Add >.and Finish.

Add and Ren'lovg -Prn]ec_ts
Hodfy the projécts that are confioured on the server

B R e A e
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Create New Web Content

__8. Open CourselistServlet.java in Q00-web.

‘;w
E§

QDCI -web
€§- @ Deployment Descripter: sqliDemoWebi
E ﬁ Java Resources

qg JavaSource

& éﬁ comlhm sqljdemo "? e

H

i -

% ! 5 B4 Cwseustserv[et _ B : @veiiian 1.0
! ; giﬁ DatabaseAccessUsingsqq,jﬁ %E, i iy gauthor

_ 9. Gotoline 111 and change QO — Course Selection to My Credits.

/% START OF HTHL HEADING *+f

os.print ln["%HTiﬂL}iE'] :
0s. r1nt1n("<HEAD>")

£ 68 PrAntin{t TITLE
oz, print.ln("<;‘HEAB>"}
os. print.ln(""}

S

/%% END OF HTHL HEXDING **3

__10. Delete from line 117 to line 122, line 124 and from line 131 to line 287, and add the 2 lines
shown below. Then click Ctrl-S to save and compile.

Lab 2 - Leveraging Existing Assets Page 25
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o public void doSecvice (HoupServiectReguest req, HotpBServletResponse respl
: throws ServletException, IOException {

ServietOucputStream ns;
08 = resp.getCutpucStreanmi);

/%% START OF HTAL HERDING *%/

og.pEincin{"<HIXL>");

os.printIn("<HEAD>"};

of.princin(” <TITLE> My Gredics </TITLE>M);
os.printin("</HERD> ")

08.printInit*¥);

/** ERD OF HTHL HERDING *+/

displayCourselist{req, resp, os}:
}

private void displayCourselist {HttpServletRequest red, HctpSaxvlebR&spnnse resp, Ser?lecwbpui;stream- _osﬂ X
try { - . . - - R
03. printin{”<BODY>")

os. println{"</BODY>")
o3, printintr</HTHES M)
os.close(i;
} catoh {IOException ie) {

System, out.printin{"I0txception:” + ie.voString(j);
} catoh (Exception e){
System. ont.printin{"Exception:” + &.voString(}};

__11. Open a new browser and enter the URL hitp://locaihost:9080/Q00-web/Coursel istServlet and
you should see the new web content in the serviet you just moditied.

Units taken: 27

Units remained: 12

Configure a Web Page Portlet

Add Web Page Portlets to a Portal Page
Follow these steps to add two web page portlets to a portal page.

1. Open a new browser and enter URL hitp:/192.168.10.2/wps/portal. Login to WebSphere Portal
using teamXfteamX as your credentials. Xis your team number. For example team 1 uses
team1/teamt, team 30 uses team30/team30.

Page 22 Discovering the value of IBM WebSphere Portal V6.1




Apilications

Welr Pages

All Bources

4.  TYPE web page in the search f[eld CIICK the 8 icon.

g, eyt o ;_g.x S T P i

G sd
IBM TechWorks

Lab 2 - Leveraging Existing Assets
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__ 5. Drag and drop the portlet onto the top of the blank Portal page. Place it on top of one of the
colored bars in the white space.

TEE

You should see the portiet. If it did not work, try agaln.

o rfrTmm o b £ 1YY MR PR ITE T o sl S 2R e e X e

Page 22
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__7. Add one more to the right hand side of the first one.

k|
1
I e - S
§ | please tusiomize your portiel fo speciy 2 vieb page. ) ;P{easg f""'s‘?ﬂizf?‘ff E"_’f‘?‘_“’ ip_e_ﬁif_&‘_e_z_\f\_fﬁgaﬁgf‘fq L _j :
l R T L Jiutuiing :
I 3

__8. Hide the portiet palette by clicking on expand palette the icon again.

All Sources

Configure the portlet

__ 9. Hover over the top-right corner of the portlet. You will see a drop-down arrow.

ortiet io specify a Web page.

__10. Click on the arrow and select Personaiize,

1 Please customize your porttet fo speaclfy 4 YWeb pags. | i'mim|;_'
O O Mra'ximfze .
Move Right
Deleie
Help

Lab 2 - Leveraging Existing Assetls Page 29
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11. Type Optional Course Listin the Title fieid and http:/localhost:9080/Q0-
web/Coursel.istServietin the URL filed. Then click Save. The Title you enter will be the name
of the iframe in this Web Page portiet. You will need to use this iframe name later to edit the web

content source.

Configure Web Page
Title:
lOptional Course List

URL:
F it ¥localhost 9080/Q0-web/CourselistServiet

aidth:
@ Fiito colirn _

@I _ ];}ixeis
Height: e

EDE} lpixels

FH Authentication Options

D toptendifetise i T ey
. Optionnl Cowses 2! Optional Courses ]
: Comse . Difesing s 3;-% Course . Oﬂ"ering .
P Comm Titte il ’é oo Tile ey it :
: ERGOI4  Enginesring mathematics Engreerng 3 § FHGRIDE  Englacerng mahernatios Engineering 3 H
! ENGO10§  Tighdlfege Engineering 6§ ENGH106  Digtalfogc ' Engneerng & :
i ENGOW?  Fendalions of compultr scitoct Engneering § , « ENGOL07  Foundations of computer stizace Engreerng . é i
1. CSEDI20  Codiputér progracatring ] Exgnsering 13 : © CSEOI20  Qumputer prograsutig Bagraéring & o . ;
: 1 CSEOf22  Coengpuber programming I Engmeering 3 T CSEQ122  Cotdputer programming 7T Engireesing 13 H
- Trirodotlish to difa strschoes & N Insoductionto data stnuckares & .
e CSEO1L2 elgorid . Engactring 3 : CSEQ119 g .. Eugmefmg [3 ;
¢ CHIOI Putonghen courst fr Enginstring studeals Arts 3 : © CHION0?  Putonshuacourse for Engreesing studects Aris® . 3 I
i1 sOCOUE  Jeomesedtw. | Seddfuimse 3 E | SOCONE  Jwsmestsodtty e Seitboemn 3 &L

__13. Optional: You can modify the size of the Web Page portlet (size of the iframs) by entering the
pixels of width and height.

|
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Develop Communications between Portlets

Trigger Refresh Action between Portlets

The following steps show how to edit the web content source in RAD so that when a button is clicked in a
portlet, the other portlet will refresh and show the web content that you would like to display. You will add
a button named “My Credits” in the “Optional Course List” portlet. When you click the button, the
“Credits” portlet will automatically refresh to the “My Credits” web page, which is the new web content

(serviet) that you created at the beginning of this exercise.
Q.0
-web in RAD.

1. Open CourseListServiet.java in @0

BE O e i
Ef}@ QO-project : Initiall
1§ B3 QD-web Hashtab
g E}‘% Deployment Descriptor: sqijDemoWebifi : parms.p
@-g‘g Java Resources ! -
. B-§8 JavaSburee. - :
_ i -5 com tbm.sglidemo, iﬁéffﬁ;‘s . P
E i}ég ﬁ éﬁ LG 1
| L[] DatsbaseAtcessisingSQLIEE try. (
-6 SQLIavaSourcs’ e | otx
@Eﬁ Librarles iy ds.:
-‘?@ Security Editor e
-F58 Web Site Navigation 3 } hatih

2.  Add the following lines after line 111.-Notice that you have put the iframe name Credits and the
path “./Q00-web/CourseListServief\” in the source. It means that in this function "refresh”, it
triggers the portlet with iframe name Credits to refresh and display the' new URL
http://localhost:9080/Q00-web/CourseListServiet.

F*¥ START OF HTHL HEADIRG %%/ -

os.printin(“<HTHL>");
as.printin("<HEAD>");
os.printin|®”. <TITLE» QO ~ Cpurse Selectign </TITLE>*

f):

es:p:ihtln("(fHEﬁﬁ>ﬁ3;
es.printlni®"); T

/%+ END OF HTHL HELDING *%/

String tran = feq.getParomster [Tacdcion');

PP ~
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__ 3. Add the following line after line 270. This adds a button that triggers the “refresh” function to the
end of the “Optional Course List” portlet.

</ Thx7)
: <fTR>"]r

02. closet},
} catch. {I0Exception ie) { .
gystem.ont.println("IoException:” + ie.toString{)):

__ 4. Click Ctrl-S to save and compile. Then go back to WebSphere Portal and refresh the portal
page. Scroll down the “Optional Course List’ portlet and you should see the button “My Crediis”.

T T T

Dptmna] Gﬁufse Llst b

7 S0C0008  Culture and sociely .  Social Scienices 6
FINO101 Financial markets and institutions - Bisiness b
CHE0013  Chemistry and daily life Sciénce . 3
ELE0115  Elecironic circuits Engirieeting = 3

6

ELEG112  Computer microprocessérs Engitieeting”

|COURSE CODE ]I Selait
| Otfering Foculy 18 |, Fillet:

List of Faculty

Shaw porder..

My Credits]
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__5.  Click the My Credits button and you should see the portlet on the right has refreshed to display

Foptioral Course List-

S0C0H008  Culture and socisty

Social Sciences 6

FINoiol Financial matleess and institutions Business 6

QHEO013  Chemistry and daily ife Science 3

ELESTIS Electronic circuts ] Eng_in‘eeﬁng 3

ELEOI1Z Computer microprotessors Engincering 3
{COURSE CODE |[8elet:

[Offeﬁng I;aoulty@ [ Fillar. }

List of Facul

End of Exercise

JPUEP— g i e e+ g T m g em e

- —

= Credis T
'§ © Uhits taken: 27

Units remained: 12
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z/OS component terminology

JES2 or JES3 - Job Entry Subsystem

TSO - Time Sharing Oplion

ISPFIPDF — Inlesacliva System Productivity Facifity
WLM ~ Work Load banager

RIMF ~ Resource Measursment Facility

SMF — System Measurement Facility
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USS — Unix System Senvices
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Chapter 5: Access Mainframe DB2 From
WebSphere

Objectives
In this exercise, we will learn:

How to login Mainframe using TN3270 terminal emulator

How to delete table using DB2 tool on Mainframe

How to create table, index and insert 1 record using DB2 tool on Mainframe
How to login WebSphere Administration Console

How to create authentication alias for Mainframe access

How to modify local Data source to access Mainframe DB2

How to run the servlet to access Mainframe DB2

Exercises
1. Click the icon to start TN3270 terminal emulator from Desktop:

2. Specify 192.168.10.4 for mainframe IP address and 23 for telnet port




4. Mainframe logon screen appears and waiting for user signin

3 5

24/008




TSO/E LOGON --

~Enter LOGOH parameters belou: RACF LOGON parameters:
Userid ===>» TEAH1
Pansword  ===p New Passuord ===)
Procedure oo Groyp Ident ===
ficct Hmbr ===
Gize
Perform

Command

" Enter an 'S’ before each option desired belou:
~Homait -Henotice ~Reconnect -0iDcard

PFi/PFi3 ==> Help PF3/PF15 ==» Logoff PAl ==» Nttention PR2 ==> Reshow
“ You may reguest specific help formation by entering @ "?' in any enptry field
] 08/020
o




9 Key»myour team ID for the password and press Enter key

Enter LOGON parameters below: RACF LOGON parameters:
Usarid ===% TEAML

Password ===> tfaw Password ===>
Procedure B Giroup Ident ===>
fcct Hmbr

Sizé

Perform

Commznd

Enter an 'S’ before esach option desired belouw:
-Homaitl ~Honotice -Reconnect -0ibcard

PF1/PF13 ==> Help PE3/PF15 ==} Logoff PAL ==> Attention PR2 ==> Reshou
You mag request spe01flc help nformatlon 18] enterlng a "?" in any entry f1eld

10. After entering correct password, the followmg TSO welcome page displays and wait

for user to press Enter key

7117006 .-



11. Following TSO Main Panel displays and press Eater key to display the full options.
- : L 2 - = o

AR =

= bk Si-
Henu Utilities Compilers ‘Status Help

Settings I - . .. TERML
View iop . i .. 1 17:8b
Edit ' ’ . 3278
Utitities PR
Foreground P HNEHEIAT : ENGLISH
Batch H : . ISR
Command i : £ E ) G logon @ DBSPROC
Biatog Test : : S 3 TERMNML
IB# Products 3 : Hucis © System ID : ADCD
: T MY¥S acci. : ACCTH

Licensed Haterials - Property of IBM ’ Retease , : ISPF 6.1

5694-A0L Copyright IBW Corp. 1980, 2009.

All rights reserved.

US Government Users Restricted Rights -

Use, duplication or disclosure restricted

by GSA ADP Schedule Contract with IBH Corp,

OO UMLK =0

22/614

TEAML
17:57
3278

Foreground
Batch
Conrand
Diatog Test
IBH Products
SCLH
Horkpiace
Hore

“N DR WN =D

fAindi tional

Sg5tém ib .
HYS acet,
Rrlgase

EHGLISH
ISR
BBSPROC
TEAHL
aDED
ACCTH
ISPF 5.1




Status

‘Setiings

Vieu
Edit
Utitities
Foreground
Batch
Command
PDialog Test
IBH Producis
SCLH
Horkplace
Addi tional

SHP/E
ISHF
RACF
HCD
SBSF
IPCS
DITTO
AUF
olvs
]
HLH
FHH
RRS
DBZ ¥9

NS ST A B B e

Help

-l—db\.‘llui'—i‘

N e Il
- == D
o X R4
KN




15 Key-in ‘1’ at the fop command line fo select DB2 system catalog

DB2 Admin
Dptian =.==) j__

TN TS TUARWR =

Database 2 Administration Tool.

5897-L.9G (C) Copyright IBM Corporation 1895, 2006.

All rights reserved. Licensed materials - property of IBN.

US Government Users Restricted Rights - Use, duphcatmn or dlsclosure
restricted by GSA ADP schedule contract with IBM Corp :

ST ST FTaR,

"“' S T 3
-~ DBOG System Catalog
ore:

TEAHL

N
DS -

P
L
K.
H
H
F
B_

]
Q
P

[
W

tee
Name
Ouiner




17 Followmg screen shows tables in DB2

GRHNT HIG

SYS0BDS SYSIBN DSHDBOS  SYSALTER
SYSCONTEXTARUTHIDS  SYSIBH DSHDROS  SYSCOMTX
SYSCTHTTRUSTATTRS SYSIBH DSHDBOG SYSCOHTH
SYSCONTENXT SYS1BM DSHDRBOB SYSCOHTX
SYSCopY SYSIBH DSHDBNOE SYSCOPY e
SYSFIELDS SYSIBM DSHDBGB  SYSDBASE
SYSTABLESPRCE SYSIBH DSHDBOB  SYSDBASE
SY¥STABLES SYSIBM SHDBOS SYSDRASE
SYSTRBLEPART SYSIBH DSHDBOB SYSDEASE
SYSTABAUTH SYSIBK DsSHDBOE SYSDBASE
Command ===

CWNRNOGDOODR

18. To show the table B in your TEAM database, move the cursor under Name left click
and type > over the * characte

DB2 Admin B ~ DBY9G Tables, Vieus, and Htlaﬁes - Rou 1 to 10 of 651

GRANT HIG ALL

DSHDBOG  SYSALTER
DSHDBOE  SYSCONTX
DSHDEOE  SYSCOHTX
DESHNDEES SYSCONTX
OSHDBOB  SYSCORY
OSHDBOE  SYSDBASE
DSHDBOE SYSDBARSE
DSHDBOG SYSDBASE
DSHDBOG SYSDBASE
DSHDBOE SYSDEASE

SYSN8DS SYSIBH
SYSCONTEXTAUTHIRS SYSIBN
SYSCTHTTRUSTATTRS SYSIBH
SYSCONTEXT SYSIBH
SYSCOPY SYSIBH
SYSFIELGS SYSIBM
SYSTABLESPACE SYSIBN
SYSTABLES SYSIBH
SYSTABLEPART SYSIBH
SYSTABAUTH SYSIBH
Cnmmand

R e e e I I I
1 .
CWUNNDDOD Q@




19. Press Tab key 3 times, the cursor under DB Name, type ‘“TEAMxDB’ where TEAMx
is your team ID and press Enter ke
GELiE s

g | T
DBSG Tables, Vieus, and Aliases -:Rou 1 to 10 of 661

GRANT . MIG ALL 7

" SYSOBDS EASN 1]
SYSCOMTEXTRUTHIDS SYSIBH
SYSCTYXTTRUSTRTTRS . SYSIBH
SYSCOHTEXT SYSIBN
SYSCOPY SYSIBK
SYSFIELDS - SYSIBH
SYSTABLESPACE " SYSIBH
SYSTABLES SYSIBH
SYSTABLEPART $YSIBN
SYSTABAUTH " SYSIBH

" Command -

DSHDBOS  SYSALTER
DSHDBOBE  SYSTOHTH
DSHDBOG  SYSCOHTH
DSNDBOB  SYSCOHTX
DSHDBOG  SYSCOPY
DSHDBOG  SYSDBASE
DSHDBGE  5YSDBASE
DSNDBOS SYSDBASE
DSHDBOS SYSDBASE
DSNOBOE  SYSDBRASE

i el o e ] o
TocwNmoooOOoS

DB2 ﬂdmih --- ~w~ Rouw 6—23 from 661

GRANT HIG ALL

niands !

Pt

TEBMI T TEBMIDE TEAHITS
> OF DEZ DHTR o




Panel Explanation

WORS You LATorNG

e panat coluy S ' ;

s
B

22, When ‘More  +* appears at upper right hand corner to indicate that it has more
information, you can press F8 key to continue display the help message

Panel Explanation:

O3y

fidmin generat
ciraractar



23. Press F3 key to refurn the calling panel and this table has 2 columns and ‘ROWS -1”
mdlcates that thele is no RUNSTATS performed

GRANT HIG - ALL

TERMI T TEAKIDB TERHIT
i T

Command ===> Scrsl ===

-- DBBG Tables, Vieuws, and Aliases

GRANT MIG ALL

TEAHIDE TERHITS

¥

Command ===>




25IhshowscohnnnsuﬁbnnaUOn.

=~ Rou 1 to 2 of 2

HRHE
VALUE

done

DB2 Admin -

GRANT MIG

TEAHL T TEﬁ $1DB TEAMLTS




27. To get help of using line command(s), move the cursor under Sel and the table, key-in
“?’ and press Enter key _ _ ‘ !

DBSG Tables, Views, and Rliases --- Rou 623 from 661 l

GRHNT ~MIG ALL

TERML : TE?HETS

Command ) . Scroil
12/003

28. It shows the line commands and descriptions. The nght upper corner shows thele are
34 lme commands.

iption

Show all columns for this row

fiuthorizations en table

Riter table or materiatized tfable

Riter table columns wiih DE2 Admin DLTER

Shou atias

Aiter table add materialized table query ] nigher}
Dizplay associated auxiliary table DE2 V8 figher)
Display associated AUYX data column . 2 V& and higher}
Bisplay associated base table A i nigher}
BROWSE R ) R
Shoy cotumns




Szlect

Shou cotumn distribution siatistics

Referential integrity. show child tables

Show iable check constraints

Referentiat integrity, show child relztiens

Display clone iable ‘ (DB2 ¥¢ and higher]
Create a comment/remark

Shou constraints on table (DB2 V7 angt higher)
Count {¥) function

Create & simiiar object

Create an auxiliary table

Create atias on tablé

22/@15 ’

30 Move the cursor under Select and beside Count(*) ﬁmctlon Tleft chck, key—m ‘s’ and
‘press Enter key to excoute this function against this table:

Show coiumn distribution statistics

Referential integrity, show child tabies

Shoy tahle check consiraints

Referential intearity, show child relations

Disptiay clone table (BB2 Y8 and higher)
Create » comment/remark

Show constraints cn table {bB2 ¥7 and higher)
Count{r] function

{reate a simitar object

Create an suxiliary table

Create alias on iable



1

DATA

Command

GRANT

FRES L

Command




33. Piess F3 key to return prev1ous panel

DB2 ﬂdmln _________
Option I

Hore:
s DBOG
gL 10 TEAWL -

Falinall -

_=

N
D3

Mo aoTMmX

o
W

Fater
Grantor
Graniee

Option

DBYG
TEANL
TERML
TEARML
915

Mhm A
T




35. Key-in ‘2’ at top command line and press Enter key to provide a panel to execute

o
FNmO DO Wl

o
>N =

DB2 Admin
Option ===




37. In the right hand side, ensure that DB2 SQL ID is your team ID

B et

AN & 3-* AN As‘ faytE=
- Execute SQL Statements
Command ===> ’ : T

06/0062
T

38. Under SQL statement, key-in DROP TABLE B; and press Enter key to delete table

from your database:

DB2 Admin Screen Input
Command === : :

iG: TEAML

EDIT on the
. F5=RFIND

IGHT




39. DBZidlspIays “DROP stmt executed” to md1cate the table ) be deleted.

DB? ﬂdmln ---~;-
Command == )

ENTER ¢

40, To verify table to be deleted, key-in the following statement with replacing TEAMx
to your team ID and press Enter key

SELECT * FROM SYSIBM.SYSTABLES WHERE CREATOR =
‘TEAMx’ and NAME = ‘B’;




41, No rows returned indicates at the table doe

= B S :

s not exist in the system catalog

2

DB2 Admin
Command =

DE2 ﬁdmin
Option

067002
:

FH=ROHAN

13/849




43. Key-in ‘2’ at the top command line and press Enter key to RUN saved SQL
 statements

B2 Admin -
Option

44. Key-in ‘1’ at the top command line, épecify “TEAMx.LIB’ where TEAMX is your
team ID and press Enter key '

DB2 Admin - e mmeeme Bup OF Explain SOL Statements ~-rrmnr---- i
Option ===%

TEAML




45, Ensure TEAMxDB.TEAMXTS and TEAMXIX are your team ID. If not, replace
TEAMX with your team ID and then press I3 key to save or ex1t

Eile gdit Edit Settings Henu Utilities

-Harning- The UNDO command is not ava11able until you change
your edif profile uslng the command RECOVERY GN

LEFRETAR

Option ==

16 TEAML

Gther
Dat
Yatus

b




47. Press Enter key to execute, it creates table B, index and insert one record into table B.
It takes a while to execute until INSERT stimt executed

R

---------------- Bun or Expiain SOL Statements -

Execute S5QL Statements
Option ===

TEARNML

0




49. keyin ‘17 at top command line to execute SQL statement to verify the table B

a2/815

50. To clear the full statement left over, move the cursor under the SELECT and right
click o .

DBZ Admin
Command

DB8G
TEAXL




to erase to EOF

ilErase EQF ) 2

- T

¢ Pad

52. Use below SQL statement {o view the table content .

[ SELECT * FROM B;

53. Key-in sclect SQL statement and press Enter key ©

gl

----- Execute SQL Statément




54, Show the content of table B:
3 AXR0

55. To exit TSO, repeat press F3 key until the following screen appears, then key-m ‘2
and press Enter key

2 1. Prlnt data st and delete
2. Deleie data set without printing
3. Keep data sot - Seme
[zliocate same data set in next session}
4, Keep data set - Hew
(aliocate new data set in next session)

List Data Set Options not available

55 ERTER
r END <

TR ST A e Ul SCUTFE Lo




~ os/o0l

eRC




58, Message IKJ564701 indicates successful logoff
S £ SR : e

T es/001

60. Enter https://localhost:0043/ibm/console and press Enter to WebSphere
Administration Console to do configuration.

Py




61. Following screen displays and ask for User ID: and Password to logon Admlmsn ation
Console:




63. Enter admin foi‘ Password: and Click “
Consol.e -

o

il https: {ilocalhost:9043fibmiconsole

{aografng §3kons Cacecss Wek st wdnte

[ e G achr
R LR

Red Sohdong Coracie. 1008 g H

. 5 S : 5
nin [
frathd wicinarikigad s v D RS petar bt n e > ¢ [ e e
- i e vivbupteiopir N RN,

o s o P = H LISOwaED AATILLALE PAPIATY 5 - ©
e D T L R e e B e, | g ! g
trates — s | prmytmenniinee,
R —— N g s . i
R e T T TS [ b et 4 H




65. In the left hand side, click ‘B’ Security to expand the Security settings

ihg

Walcome

B
D T_-é‘.‘r

s : A Integrated Solutions Console proyide
e ? S s through this instsllation, Select a| o

oy

% !V{%;,S_Lie Application-Servaer

BRGRGREEEE e a e | - S




66. Click "Global Security” to create authentication alias for Mainframe access:

Help 7

https:Hlocalhost:9043,€ibmiconsuleﬂog[n.du?action=sécure

Welcoma

Vi%_w:i All tasks

S T T e e P T T T

Welcome

i Gaveds G B
-—&ﬁ@gf‘g&f

TR e, ?ﬁg‘?, o
e
2 S ,7_?"".: -

I

!

Integrated Solutions, Gons
through this installation. §

£

H. Administrative Authorization Groups

881 certificate and key management ; . ‘ .
$ecurlt§l ad_ditin?j T ' ' .
Bus security

B




67. Wait until the following Global Securify screen appears:

:r.u..aqs.
{n S0n pcat
et and [ pabit s i e n o S oty
L

Fgremey { Totrdy Lonaman Bipos §

Wawt |

Aitact on iy

1P B bt searty + Sdmscutsegent
e & Ao iteied gyt D
¥ Adriss sy asterresy
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. w&‘n‘a‘n&ah‘l—i
* Al b Sosaaet

bttt ©
B3 eaabin saplorran rasety

smrbay

¥ Ure Jren2 easumty ba st upabortm borad 4 1 bocad
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68. In the right hand side, under Authentication box, click “Bl” Java Authentication and

Authorization Service” to expand the list of options

Auvthentication- - - e S -
Authentication rnechanisms and expiration
i *Kerberos and LTPA
Kerberas confiquration

Authenticatign cache setings
Web and S1P security

RMI/TIOP securty

Java Authentication and Authorization @

B Qacurity demains
8 Eaternal authorization providers
2 Custom properties

£ swam {deprecated): No authenticated communication between servers




69. Click ‘J2C authentication data’ to create anthentication alias for J2EE connector

Authantication

Authantication meachanisms and expiraticn
LTEA
- Kerberes and LTPA

Karberos configuration
© swam (depracated): No authenticated communication betwean sarvars

Authantication cache gettings
web and SIP secuvity

RMIZIIOP sacurity

CiE Java Authentication and Autherization Sérvtceg

=1 Agglicaﬁon logins

Use realrn-qualifiad user names

# Security domalns
# Euternal autherization providers
# Cystom propgrties




70. Click ‘L Mev P button to create new authentication alias to access Mainframe

i
|
3 Global security = JAAS - J2C authentication data )
: Specifies a list of user Identities and passwords for Java(TM) 2 connecdtor sacurity to use.
Prefix new alias nameas with the node name of the call (for compatibility with earlier releases} l
CApply | l
‘ {
=} Preferences ‘
Maxlpum rows )
[zo i
. \
El. retain filtar citera . I

SAMDLE ' . : S s l{

U DB ' . - i db2zadmin

" [F} | ot lagln . S P db2admin

71. Specify jdbe/mf teamx, replaces the teamx with your TEAM ID

lohal secyrity > JAAS - 12§ puthentication data > New
!_ 8pedfies a list of user identiias and passwords for Java(TH) 2 conneckor securily to use
SensrsiBropartles SRS 1

* 9a§£wqtd.‘ e




72. Provides your team ID for User ID which has been defined in Mainframe as DB2 and
TSO user '

ahul security > 1848 - J2C authentication data > New
gpetifios & st of yser idantitias and passvords for Javs{TH) 2 ronnedor security to use.

ﬁaﬁgt*a! Praperties

8l

P4 Alias
[icheint teamt ]

s Pagsword .

Besalption |

73, Provides the password which is same as the team ID and Click
the settirigs

% Global spcwmity > JAAS - B Hond 35 _ ‘ o
Epedfins 3 list of user identitles and passwords for Sava{TH) 2 connechor sacurity to Gse, o

Gﬁ'g%rai pl?pe’tﬁes__:‘, o i . . = S N 7, e — —

! % Allas — e
e S

gUgerid B

]

ok ) [Reiet] [ZCanedl|




[EIRer

74. Click 8222 to save authentication alias fo master conﬁguratioh.

H Hessages

m ta the qraster configuration.

Globsl secarity » JAAS » J2¢ suthentication fals > fdbe/mf_teaml

i
H
i

Archenges have been made to vour lods| configiirstion. Vou £a0:

*® Revicw chahges hefore saving oF discarding,

B N e s e i TR T A At Tk 8. L T

; OThe varvar sy head to ba restartad for thega changes to take affect,
3
|
|

spaciios & hist of user identitiss and passwards for Java{Th) 7 éennackar faeurity t4 dfe.

- - — -

Geneyat Broperties — e

s
TR AN Ty

LTy a‘:;;;’ TS

R

et ot
RS e

SHER L

TR 3

EPAS

]

75. In the left hand side, click ‘#’ Resource to expand resources definitions

Integrated Solutions Gansela provides a camm;
through this installation, Select a produrt suite

R

ERALR St

Loz TS
& Schedulers
2 Object pool managers

"'l. providers :

B FLiata sources -

B pata sources (WebSphere Application Server W43
Rasource Adapters . :
Asynchrencus béans
[ Cache instances '
Mall
URL
Resource Environment

Integrated Solutions Censole provides & carrimon ;drj1in_is§:i
through this Installation, Séleck a product suite to vlew mora

e

f?mz&u"‘“ D e D LI
iwehSphere Application Sarvar
SR L




77. Click Data sources and wait until below Data source to be displayed. We are going to

(e zsTr AR
i g

3.
s

2 gchadulers

B object pool mansagers

M s

EJDBC o

LB JDBC providers
# pata sourcss (WeESphere Application Server V4)

@ Resource Adapters :

: -E-] Asvnﬁhronqqs, beans

[ Cacha Instances

fhail

2 URL

i
i
! .

HEEEH

RS AT

s

modify local MF Data source to access Mainframe DB2

Data sources

Use this page to edit the settlngs of a datasource thatis assotlated with
accessing the database, Learn more sbout this task in a gulded activity.

A $copei CellmswgwinxpNodadiCell, Hode=swgwinxpNode0l, Server=s

Scope spacifies the feval at which the resourca definition is visit
it works, sée the scope settings help.

l tiode=sygwinkphlodanl, Servar=sarvarl ﬁi

] Preferences

& gchedulers )
o i‘?"c-'hj_ect‘pool managers. -
HAE
0BG
© ® JDBC providers
‘R Gata'sources] ' o
B Pats sources (WebSphere Application Server UEY)
[H Resource Adapters ’
= Asynchronous beans
Cathe Instances
{2 Mail
# UrL -
{#] Resource Environment

Data sources

Use this page td adit the setdngs of a datasource thatis, assotiated with
accessing the datsbase. Leam more about this task In a quided activity.

[} Scopel Cell=swgwinxpNode01Call, Node:swgwlnxpN_udeﬂl,. Sarver=st

Scope spedfias the lavel st which the resource ;Sefinltibh is l.rl_sil

1t works, see the scope setiings helpe "+ 7

mde=swgw‘lnxpﬂude01, Sérvar=serzerd BB

B Preferences

T A e PR e 0

o




79. Seroll down the scrollbar until you see the Security settings box

i

Data sgurces > MF

for accessing the database,

Canfiguration t

Use this page to edit the settings of a datasource that is szsociated with your zelacted JDBC provider. Tha datasource objeck supplie

General Proparties

i

L
AR aeees

Bty
a"kﬁgm

# Scope
[celis ' swgwinxpliode@l@&ﬂ:nadesxswgwinxpﬂodeni:sewe:s:semerl_l

# Provider
[OB2 Universal 106¢ Drivar Providar (i28) 1

* Nams ‘ -
JNDI name .

fidbeint ' 1

Use this data source in container managed persistence (CHp)

Dascription X
DB2 Universal Dilver Datasoes ‘
Category

1

| [ata store helper class nante

D getect a data store helper class

Data store helper classes I

DEZ-Univarsal dats storehalps
(zoraibrn, vebspheare, 7 adapten DR 20N

DBZ for ISeries data store helper
Leermibra vebspharersadapter DR 3400Patastwetelpar)

wersaiDatpStoraiidipar)

@SPECW“' a user-defined data store helper

Later & dacdh pgE Uy 5 he

|| Seeutty seftings -~ oo m e oo
select the suthantication values for this resource,

Authentication alias for XA racovery

mf_togin %

Additional Properties

# Connecdion pool proparties
# webgphere Appliestion Servd
= gustorn propetties

+ b

felatad Tteins i
8 A4S - J2C aum'-entication' da




80. In Security settings box, click ‘#8° under Authentication alias for XA recovery, to
select jdbe/mf_teamx which is defined at the beginning of this lab.

;- Sewiity settings -

Seledt the authentication valuas for this resource, T

Authentication alias for XA recovery
imf Togin,___H&
I(Jn_%n;) d authantication =slias
SAMPLE
: ¢ jsampla_login
; mf_login n alias -
i
efmf teamtiio s
Container-mansged authentication alias
| mf_login &

81. In Security seftings box, click ‘¥4 under Component-managed authentication alias,
select jdbe/mf_teamx which is defined at the beginning of this lab.

Security settings
Select the authentication values for this resource.

Authentication alias for XA recovary
jdbe/mf _teaml &4

Component-managed authentication alias !
[mf Togin 150 _ ;
: E_,n%n;) ‘ n alias ' . '

' | SAMPLE g|

sample_login .
mf_legln bged authentication alias

82. In Security settings box, click %% ynder Container-managed authentication a'lias,
select jdbe/mf _teamx which is defined in the beginning of this lab,

. Security settings - - - - T
i gelect the authentication values for this resource.

Authentication alias for XA recovery
jdbcimf_teami 55 ‘

Component-managed authentication alias
jdbefmf teamil §E o
Mapping-configuration allas

! {none)} @gg]

Ceontainer-managed authentication alias
[ sdbetrof_teami 5

1




3. Scroll down to Common and required data source properties under Security settings
7 box, change Database name to DALLAS9 which is mainframe DB2 location name.
H | jdbefmf_teaml &_al ’

tiapping-configuration alias
mone) @l

i Container-managad authentication alias
| sdbefmi_team1 2

tomman and required data source properties ~ -

% ai: Driver type 4 555

H .

i # Database name DALLASS ‘ : i
%! # Server name flocalhost |
i # Port number [So018 - ]
? L

!

84. Tn Common and required data source properties box, change Server name o
Mainframe IP address (192.168.10.4)

- Common and requived data source propertias, — 7 77

SeEiEa L

& Driver type

+ Database namea

#% Server name

# Port rnumber

85. In Common and required data source properties box, change Port number to
Mainfrgme 1P port _n_qmbg_ij (50_2__5).

i
tommon and raquired data sousce properties

LBl te

# Driver type .

% Database name

FDtALLA-SQ- 1

# Server name

[192.188.10.4

% Port nurnl:'ter'

q5025 . >




—_

86. Data Source modiﬁcation is done, then click Lok I to finish the change.

Commnian and raguired daka source propertias

E3 Drlua typa } . 4 ‘Ljyg

# Database name - {paLLase 1
% Server namea . E192.168.10.4 ;
% Port number [5025 i

87 Chck ¢ gaca’ to save the chan%e directly to the master conﬁguratlon

5701

Qges have been mada to yaur local conﬁgurahon. You cant
irectly to the master conﬁguraﬂon '

) . changes before saving of dnscarding. ST

&The server rnasr need to be rastarted for these changes to taka effect.~

Data sourvcas

Use this page to edit tha seltings of a datasource that is assoclat
atcassing the database. Leam more about this task in a quided activity.

B Scope; Cell= swgwmxpNodaDltell, Node=swgwmxpNodenl, Sarver=serverl

ad with your selected JDBC provlder, The datasource objecl: suppltes yaur apphcati
A guldad activity providas a list of task steps and more ganeral Informatio

Scope spacifies the fevel at which the resourca deflnmon is ulmble. Far detalled |nfurmat10n an uhat scape Is and how :

3 works. see the scope settings help, . . e LN
I HodermswgulnxpNodell, Server=sarverl ﬁj - 3

El Preferances

Nnde-swgw]nxpﬂodeni Semar—sewerl N

Node“sﬂgmnxpNodeDl Semer-sewari:

Brovider (RA) "



good or not, click ‘£F of modified MF data source and then click « Test cennaction * to
test that. '

el pRagelL Cell, Prame=was/iprolied . __

88. To verify whether the connection between the Websphere and Mainframe DB2 is ] _

Data sources

Use this page to edit the setlings of a datasource that is associated with your selected JDBC provider. The datasource object sug
e,

accassing the database, Learn more about this task in & guided activity, A guidad activity provides & list of task steps and mor{

Fl Scopel Cell=swgwinxpNodebiCell, Hode=gwgwinxpModed 1, Servar=gerveri

Scope specifies the level at which the resource definition is visible. For detailed information on what scope is and how

It works, seas the scope settings halp.

rﬂode=swgwinxpNode91, Server=serverl “%;l

F Preferances

it = .. R.';!':‘-r:_: ek = s . .ﬁm 3 A %- Tt TR LTS e M %
pefsult Datagource . | DefaulDatasource

SAMPLE - - . - SR | ugilnxpiodel,Sery

RLEEenRS

89. Successful Test connection Message displays as below:

T ell=SWo AR PHOTECLUEN, Frofie=nas /0protiel

O Messages

El The test connection speration for data source MF on server servart at Héd.e"sggtélnxpr«liqcie@__‘t wasJi cl

Data sources 7




90. Need to recycle WebSphere to pick up the change. Click {in the task
bar at the bottom of desktop to switch to RAD application development environment.

91. Right Click d, it pops up a list of options that

can be selected

Recormert Onlall pronass

Server configuration ' »

Uriversal test chient . ]
| Adminstration

Pmpexties

T

92. Click d to cycle WebSphere Server to clean up connection pool buffer and
ick up the change.
i : ." ‘;\\;i; “' 34

Chri-Ak+S

| B publish CirleAk+P
Clean...

f&; Add end Remove Projacts...
Monitering

Creats tables and data sources
Resoraedt dabug provess
Server configuration
Universal kest client’
Administration

Froperties . ARk+Enter

pilef %




93, Key-in http:/localhost:0080/WAS-lab-web/MainframeServlet to start Servlet to
Mainframe DB2 '

it Ylew

94, The values in the green box are stored in Mainframe DB2 table. You have
successfully completed this LAB, Well done. Congratulation.

MainframeServiet

At ]

localhost:9080fWAS-lab-web]
s : T s )
CE

Distributed Transaction - Display

‘Running S0L on SAHPLE qataha“sea SELECT NAME, VALUE FROH A

___________ +_.___ [ —
NAME | VALUE
——————————————— +._-......_...—__._._...._......
SAHMPLE { 9

e e e st s e et At e e e e e B e 2t e e e o i

95. Well done. Congratulation.
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Agenda

sIntroduction to tegrated Development Environment (IDE}
«Introduction to Static Analysis

*Real World Static Analysis Examples

*Lab

Whatis integrated Deveiopment
= Anintegrated development environment (IDE) also known as
integraled design environmeni or integrated debug ing anvironment

is a soltwava application thal provides comprehensive facilities to
compirler programmers for software development. An IDE normally

consists of:

~ Sourca code edior
-~ Compier andfor an interprates
. # Coge visuafisation {00!
» Buiid autornation tools
» Dabugper or Profier
~ Version Control tood or adaptor
7 Runtinw test enviroamant inlegration

%

I
I

Module 1 - Introduction to Static Analysis

Eclipse (Open Source) IDE
winee ecfipse.org (frea fo download)

= Mulii-language sofiware develognent environment compeising an IDE and
a plug-n system 1o extend ®, it is wiitten primari In Java and can be used
io develop applications in Java and, by means of the various plug-ns, in
olher Iangug{ggs: as well, including C, C++, COBOL, Python, Perk, PHP,
and others. {DE Is often ca¥fed Eclipse ADT for Ada, Eclipse CDT for
C, Eciipse JDT for Java and Eclipse PDT for PHP. v




Essentials of IBM Rational Software
Analyzer, v7.0

Eclipse Architecture

Commercial Tool: IBM Rational Application

Developer

1BM Rationz! Application Developer
for WebSphere Soflware (RAD) is an
integrated development envitonment
(1DE) that extends Eclipse,for:

» Visualty designing,

a Constructing,

« Testing, and deploying Web

appication, web services, portals,

and

» Java Enterprise Edition (JEE)

applications.

Workbench basic

By
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Module 1 - Introduction to Static Analysis

Perspectives, views, and editors

= A perspective is a collection of views, toolbar icons, and
menus, grouped to accomplish a specific type ot work.

«A view supports editors and presents information differenily.

vEditors allow you to modify the code.

»Every perspective has a number of views; most have an edit
2

area. L et s b

Perspective




Essentials of IBM Rational Software
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Perspectives Views
) »There are two states for views
» A parspective defines the inftial set and layout of ¥ Single
views ia the Workbench window. sThere are no viher views at that position in the perspeclive
: T 5 + Stacked
« Each perspeciive provides functionality aimed at - S £ «“Thsta are ofher available views, represented By 1abs at tha top of the view pane
aommlsging & speciic fypa of sk, of works vith 1] S levameomia = . .
specific fypas of resources. ‘ ' eyl D B D B pesd it 8 8 :
5 “w Bt empetirication scarale Patres Baskel
E L5 ey Ao ¥IIE oLL A1 BT the AL E
= Perspactives controt wisat appears b certain menus © e T Frepeha < 1t i
* and foofbars, & £ Singte Trctog sestmuns =t sl
} Thiey define visible action sels, whichyou can £ 5 jg] view Setog em1d » prapitian
change 1o cusiomize a perspective, - § 2 B entamre e
{7 & g
w5 O Fopm=patrm
{ EBbukr
o O Wit
 EFMLAF
& est ]
+ g5 w1 « 3
A apoietee. o wiBamnanmr T

. . . éi-_%?i ) “

Rational Unified Process (RUFP) Project Lifecycle

Fast views
= A typical software development process congists of the
*You oan quickly open and close fast views. following phases and disciplines
} This functionafity Is avaiable via the fast view bar S
*Thera are two ways lo treate a fast view: » Each phase Is broken into Herations
¥ Drag & view onlo tha shoricut bar .
» Right-click the view icon ang choose Fast View -
»To restore a fast view, right-ciick the lcon in the shortcut bar, and clear the Fast
View option.

Feitadr FaLis
7 pub s
Fetcas FRSESS v alle P
Kretug rlistios = ceRgeira;

Eiring aseat £ 02ACEr
I it

TR TR

" Yterations . .

Module 1 - Introduction to Static Analysis
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The high cost of fixing defects A real-world example: Ford recall
» A single defect can cost between $12-18K. = A {wo-year investigalion determined [7= 2 araia
that the problem was system- Ford Recaling 3.0 Miton Vel
» Thousands of potential defects In a large piece of sofiware refated. 5
can cost between $600K—$2.7M.A « Pain includes:

¥ costs of the recall Riself
»bad PR

+ customer satisfaction
» potential safety lawsuits

» Potentiat cost {0 manui;acturer of
$54 million dollars.

Fot T i Ly danb ot
eTab etk b 1V 2508 D
o 2 2

Fard Gor Lk e
o By TGh B4 WSV b pezernd
whres

° qerecw eany m e Agile Process - Test Driven Development

lifom,fc!n

= A technique involving short iterations, where:
» Naw test cases covering new functionality are wrilten first.

» Next, the production code necessary 10 pass tostsis
implemented.

» Finally, the software Is refactored to accommodale
changes.

: . |
C\ldqm (‘;Qﬁjg%%)w{ )
N R
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Essentials of IBM Rational Software /( éJ}( oy /\ )?5 . 0 o
Analyzer, v7.0 ' 7[ t / o [pd7. Colorel

//f/‘i 7&"{;51{’ (i ![ \/J I N /r,(

Peer code review ’ Adherence io coding guidelines
= A systematic examinalion of source = Coding guldelines are ey
code by human experls, ' important for a number of T s R
. reasons: . " et gt e
» B0% of the elims cost of aplece | L ARSI
¥ Intended to find and fix mistakes of software goes 1o mainfenance. : .
overlooked in the inifial development : s ottt et
phase. _, * Hardly any software is maintalned .
for ts whole fife by the original LI NI T
author, iz surtta totem ersmie
» improves both the overall quality of » Adhering 1o 60ding guidel eyepdvese
' ekl ng 16 coding guidelines e e
software and the developers' skills. P rovon the eadubidy of Ine £ ;
software, allowing engineers o :
undesstand new code more o
quickly and thoroughly.
. IEY . IEEL
The static analysis tool What is static analysis?
= Processes such as agile development and peer code review « Static analysis is the siudy of source and/or binary code
that is not currently executing. -

are not enough.

» More and more, we need the assistance of automated analysis = Static analysis can:

{ocls such as IBM Rational Application Developer that can .

ensure adherenca to coding guidelines. » Ensure that the source adheres to a predefined coding standard.
. . . » Detecl cominon performance problems.
« The best lme to find problems is o review the source code as

it is written. ‘ » Understand the dependeneies of the imporls of each class.

Module ! - Introduction to Static Analysis
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Analyzer, v7.0

Static analysis vs. runtime analysis Categories of static analysis - Code Review

: « Performs automated code parsing
+ Each source file Is loaded and passed through a parser that looks for
particular code patterns violating a set of established niles.
= in some languages fke C++, rules aze bult into tha complier or avaliable In
axtemal progams Eke Lint,
« in other languages ke Java, tha compiler does Itle in the way of
automated code review.

= Code Review is a good tool to:
¥ Enforce coding standards
» Find basic performance problems
» Find possible AP abuse.

(CaTegores OT STANC AnaysSs = Goug | TCATEYOTIeS OT STANT analysis - Go0e
Dependency Complexity

= Does not examine the jormal of Individual source files. » Analyzes the program code and compares if to established
gofiwara metrics

» Delennines if it is unnecessarily complex.

» Examines the relationships between source files {typically

classes) to build a map of the overall architecture ofa .
rogram, = if a particular piece of code exceeds a given threshold, it can
prog
’ . be fiagged as a candidate for refactoring to help improve

. malntainability.

» Gommonly used to discover known design patterns {good) or
common anti-patterns {bad) in code.
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Analyzer, v7.0
f
Categories of static analysis —~ Trending Real-world Example in Java #1
' = Trend analysis does not use code arlifacts directly.
' » Rule: “Always surround If and loop statements with curly
braces”
) « it is the study of improvements/degradallons in code quatity o sition )
| based on other forms of analysis. a1 1)1
J » Analyzing the resuits of analysis. anotherMethodCall ()5
» Results generated by trend analysis typlcaily appeal {0 v What was ihe developer's intonded behavior?

‘ managers and exesutives. * Is this a reat bug?

» They make a statemant abotn the direction of quality improvements,
answering the question "is the code getting beller or worse?

L}
lanft

Real-world example in Java #1 Solution Real-world example in Java #2

> = Both method calls should have been called when the “If” was « Rula: “Avoid returning null Instead of Rerator™

{ruo
public Iterator myMethod{) {

if¢ condition § { 1ist list = getList(}:
methodCall () 1f{ frueCondition } {
1 } anpthertiethodCall (}; return lisc.iterator(}:
1

l return nully

« This was  resl bugt ! > {04 T Q

i * What's wrong with this?

| Pt {\L\:)} 0!)) /
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Real-world example in Java #2

Real-world example in Java #2 Solution

s+ Inline usage of myMethod(}

for( Iterator it = myMethodt); it.hasNext(}: LI
#/ Do something
3

- Ilfnﬁ;rE the right conditions mylethod() ean return nufl resulting
n !

® This Is particuiarly bad because “the Aght condition™ may not
happen untlba customer execules the coda.

= Modify myMethod(}

public Iterator myMethod(} {
List list = getldsti};
if{ truecondition } {
return list.iterator(}r

H
return new hrrayList (0).iterater{ls

Real-world example in Java #3

Real-world example in Java #3 Solution

= Rule: "Avoid multipls invocations of the same method”

public static void satisfy{ List fullnist, IRwlerilter £ilter ) [
for{ 1terator it = fullList.iterator(}s it hasNextlls } {
asTNade npde = {asTRodelit.mextil:

toolean satisfled = filter.satistles{ node b4
if trfirter.issuccesstuli)
it refliter.isinclusived} &t 1satisfied)
1§ trfitver.deinclusival

&c satisfied)))
it.rexovaids \\
NI
; W
<« (7

(&1

» Why does filtar.ieinclusive(} get called twice?

3

ek
&Q (‘)m‘ﬁ\w’\

('{a\é“ (@g‘x‘# AL .

Module 1 - Introduction to Static Analysis

R

« Sometimes a seemingly harmless call is expensive
= Add atemporary variable

public static vold satisfyt List fulltist. iRuterilter filter 3 (
boolean Inglusive = filter.isInclusiveils
for{ Iterator it = FullList.iteraror{}s it.hasNext{l [ |
AsTwode node = [ASTHodafit.nexkils

bostean satisfled = £ilter.satisfiesf node Iy
4f {riilter,istuccessfuld)
1] trinslusive Lk isatisfied)
11 tiinclusive &i satisfiedd)) €
jt.removeih

{

(j"‘ o




f

Essentials of IBM Rational Software

J Analyzer, v7.0

Real-world example in Java #4

Real-world example in Java #4 Solution

= RAuls: "Constder using HashSet Instead of List”

1ist employses = pew ArrayListils
1f (lemployees.contafnsiemph) {

erployses.addiesp)s
}

= What is wrong with this code?

Lab Overview
= Create Rule for Analysls
= Configuration of Analysls
= Analysis the project
Enfoy your lab !

« Sets assure unlquensss without requiring programmers
to check for duplicates

Sot eployees = oW Bashsat(ls
erployees, addlemp)r
« Better gefformance since it does not require searching

through the entire collectlon
= If order is important use a LinkedHashSet

Module 1 - Introduction to Static Analysis




Chapter 6a: Software Analyzer using IBM Rational
Application Developer |

Start IBM Rational Application Developer (RAD) to develop J2EE application which
will be used during the programming contest, RAD is a GUI infegrated development
environment (IDE) which is used to perform J2EE and web programming, The resultant
programs will be published to WebSphere Application Server so that it can be executed
in the web environment.

1. Double clicked the icon "IBM Rational Application Developer” on Desktop to
start. '

L Contest 2011 -
B promm guem  Jaiuary 20, 2011 |
fm sai&.-am 7 R

(Saturday) §
Gliftons,Central |

X sottware
s R
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2. Bamner will appear and a “Workspace Launcher’ window will appear which
allows you to choose the base location of the workspace, type:
“C:\Documents and Settings\swg\IBM\rationalsdp\workspace™ as workspace.

Select a workspace

Rational® application Developer™ for WebSphere® Software stores your projects in a folder called a workspace.
Choose a workspace folder to use For this session, ‘

Page 2 Software Analyzer using IBM Rational Application Developer



3. To config a rule, select window > Preferences

Hew Wirdow
BreEAs

Open Pes speciive
Sheo View ¥

Customize Perspattie. .

Ed Sarves Perspective As,..

2 Reset Perspective..»

o Close Perspective

. g 25 JavaResouces Coss M Perspertives

i ‘ é'_ﬁlwaswce R i

{ ' @ 5 com.bmsclidems _Redgdton
: E Coursel ktServk

i

; DatabaseActess
= SQU-‘EVaSwrca

@ 2% Lbraries

i Jp Seturty Editer
i + ER Web Ste Navigstion
! g g soumisapts
: & (5> webContent
%%-wmabmm
| @ & wastsbweb
$ e LIRS 3
} e aymkamt,pe Refecen:estaw‘erktyw Datebaseit.
. aylist Is & ran bype. Referen:estogﬂwmlypa Datebaseht..
& Arrahit b 8 re type, Referentes to genanctyps Datubase.k
& Frearllst Barawtype Refererces tupenedclype DatabaseRt...
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4. Select Software Analyzer > Custom Rules and Categories

|

lEpe filker toxt

(- General
- Agent Controller
G- Ant
i~ Backward Compatibility
- Crystal Reports
f#i- Data Management
@ Ecore Diagram
Ig Help
- InstallfUpdate
8- Java
- Java EE
G- JavaScript
o - S
i Jython
_ #-Modeling - -
- Plug-in Development
{@- Profiling and Logging
- Report Design
‘RunfDebug
- Server .
i Service Policies

- Test .
i Yalidation

- Web -

- Web Services
B-XDoclet
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5. Choose Parent Category Location as “Java Code Review”

Choose Parent Category Location
Selact the parent category where the new catsgory wi be added

-2 Deslgn Principles
@ Globalization
[3-(D J2EE Best Practices
ésf_(? J2SE Best Practices
B3 Junit
EEQ‘:} Maming
B33 performance
(-2 Private API
Qé? Security

Page 5 Softwarc Analyzer using JBM Rational Application Developer



6. Enter Category Name as “programming contest 20117

Enter lﬁategnr{r Name

Enter thie name For the new category

Page 6 Software Analyzer using IBM Rational Application Developer




7. Confirm the category created, and "Add Rule...”

[tvpe filter text

] General
-- Agent Controller
@ Ant
*.. Backward Compatibility

- Crystal Reports
&t {ata Managsment
E;F} -Ecore Diagram
@-He!p

- Install{Update
El*} Java '
- Java EE

'- JavaScript

L IPA

- Jython

- Modeling

@ Plug-in Development
- Profiling and Loaging

i‘ﬂ Report Design
[ - RunjDebug

- Server

- Sarvice Polides
L. 5Ip

&} Software Analyzer

{E -Tea
- Test
i+ Valldation
@ Web

@ Web Services
[-Et XDoclst

@E

S
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8. Select the parent category as “programming contest 20117

Choose a parent category
Select the category where the rule will be added

Java Code Review
él@ Design Principles
@ Glohalzation
-- G? J2EE Best Practices
@ J25E Best Practices
G- G Ut
5 G5 Naming
@ Performance

city
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9: select template as “Avoid calling a specific method from a class”

Select Template
Select a template to use For this rule

)

-~ Avoid catching a spedific exception

R &wvoid defining & speciflc method in classes that extend a given class

t <= avold defining a specific methed in classes that implement a given interface
t. o2 avold extending a specific class

G2 Avald implementing a spedific interface

.3 Awold referencing a specific package
& pvold throwing a spedific exception
L -3 Use a specified copyright comment

Page 9 Software Analyzer using IBM Ratjonal Application Developer



9. Assign Template Values

Assign Template Values
Flll In the values associated with this template
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10. Type “Integer” to select matching class.

e
: (C] IntegerArrayAtirHelper
@'«?; IntegerArrayFleld
; @EFInEegerﬁrrayPack
i ® InteqgerAttrHelper
&“, & IntegeraAttrbute
it (8 Integerattrvaidator

%S IntegerCache

@‘E' IntegerComparisonTerm

& IntegerComponentRaster

@ IrtegerConverter

| B IntegerCounter

@ IntegerCPInfo

€] TntegerDivideOperator - org.apache. commons.el - CiiRrogran Filas\IBMISDPsurtimesibase_vZipluginslcom.il, -
1 8 IntegerDivideOperator - org.apache.taglibs,standard Jang. jst - ei¥Program Files\IBMSDRruntimesibase_v7

Jnifﬁﬁﬁl"}' e i
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11. Select parselnt(String) as match method.

.~ 8 ° toStringint, int)

L @ 3 toHexstring(int)

L @ B toOctalstring{int)

i 65 toBinaryString(int)

;o § toUnsignedString(int, int) .
L @ ¥ tostring(int)

A § getChars(int, int, charf1}
- &i stringSize{int)

R valueOF(String)
eb valueCF(int)
+~ @ ° Integer(int)
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12, confirm the custom rules as follow,

type Filtar baxt

=R General

£ Agert Controller

& At

i~ Backward Compatiblity

@3- Crystal Reports
- Data Management
-Ecore Diagram
®-Help
-- InstalfUpdate
-@ Java
-< JavaEE
EEI JavaStript
L-IPA
i Jython
- Modefing
& Plug-in Davelopment
- Profiing and Logging
@3- Report Design
(- RunfDebug
EE Server,
L Service Policies
- SIP

E} Spftware Analyzer
: e

£ Team
G- Test

i Yalidation

a3 Web

i Web Services

B2 programming contest 2011

-@ Avold calling java.lang I

&~ sDorlet

rteger.parseint() :

Page 13
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13. Right click the project, and select Software Analyzer > Software Analyzer
Configuration...

s

PRASHELIW ¥

€

Cietay
Delete

¥
AkSHAtHT P

—————r

o e TED

@Wﬁ&&&

%

Tenprort

é} Refresh
Close Project
Close Urrelated Pfofects

ﬁﬂl{@‘m-

B e
51

s

Gizstorrizef8ind SQLY Profiles...,
RunAs
Debug As
Profio As
h-nstnmehtatlm Source
Team
Compare Wih
Restors From Local Histery..
wab Dovelopment Took

- POE Tools ’
JayaEE
Services
IPA Tools
Source

QG-'NebiJava.‘vou i Iine 93
QO-webiJavaSou... e 93

Qﬂ Neb;[(;b =
Q:Q'% i

Properties

"Page 14

Software Analyzer using IBM Rational Application Developer



14. Select the “Q0-web” as Analyze selected projects

s fiee e
B fﬁ Software Analyzer

-5
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15. Clear the Checkboxs in Analysis Domains and Rules, and check “programming
contest 2011”

Create, manage, ahd run eonfigurations
Select  range of inputs from the scope tab and at least one rule from the rudes teb to creste an anclysis configuration,

E] 3 Destm ?:hcqiﬂs {Bis]

B¢ Globaization [0}47)

£ [F]63 J26E Best Practices [0f32]

& 162 725€ Best Practices [0/241)

{163 kit [0/6)

61162 Neming [0/} ‘
E={] @ Performance [0/39]
H-F]E2 Private APL[0}3]
B-F16R mogramming contest 2011 [11]

- @-Fl e Secuy[0j26]

1 Pirer matched 2 of 2 items
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16. Rename {o “Programming Contest 20117

Create, managé, and run configurations
Select a ranga of inputs From tha scope tab aid &t kast one ruls From tha eules tab bo creste an andysis configuration,

HElEGE R )
% [F10:2 Desion Principles 075]
B8-FI02 clobslzation [0[47)
@TIED rome Best Practices [0/32]

5 ]G 1256 Best Practices (0241}

5 P62 s 1070 '
-6 Namng [0/1)

& [k performance [0f39)

B 162 pavake AP1{0f3)

8 {7) (2} progeamming contest 2011 [1]1]
& {7} Seoury [0/26]

5 TAR]

Fiter makched 2 of 2 Rkoms
T =

P
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17. Check the “Avoid calling java.lang.Integer.parselnt()”

create, manage, and run configurations

Select & range of byputs From the scope tab and &t Jeast one nde from the rules tab to create an analysis configuration.

=] §f& Software Analyzer
- B9 prodfatiming

£
S} Raming [0]1]
8-FJeD performance [0/39]
& F1E2 Private AP1[0/3]
E+-[Z168 programming contest 2011 [1/1]
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18. Run the analyzer with click Software Analyzer > Programming Contest 2011.

13

% jeva.ic.I0Exception:[]

oy Shom In ARSHTEEW ¥
1w Eﬂg’gcm ahc by ed.an 1.0
gég £8 Copy Quatfied Nams st hox
EE c 13
I é" @Pasta . class CourselistServlet extends HevpServiet implem
v ] § Delets Delzte .
by Buid Path vi,
Refertor Betshit+T ¥ 4, =
&
0 s B dsplayCorselist{HtipSer =y

statie final lonyg serialVersion¥iD = 1L

1

rivate

£ Refresh
Cose Project
Cose Urrelated Prajects

& ks

Vaidat

GYRE s G- —

H'ﬂf" i 4 o e -
e 8- - Lt
%= X
aE

Remove 5961 Suppit
Custorizefid SQLI Profies..,

Compars With

Restore from Local History..,
wieb Development Todls
PDE Tooks

JrvaEE

Sarvices

WA Tooks

Soures

Properties Alt+Enter
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19. View the analysis result

if (2alectFacultylb == —1)

é' pa.print {"SELECTED ) ;

i

& os.p:_iny.l.n_tﬂnbuzﬂ"—1k°>9£fering Faculey</OP.
i ?gg Java Resources Arraykisg facultylList = DatebaselcrcessUsing® !
H] -8 JaraSource 2 a TR0
T : - O . = 2 aed .

f’ : ' é-,{ﬁ com b sdide far (int ii D; i< faculcyl.ist.sizeé:,, i +" z @4 doGetHitpSenvietR .

; : . E‘{DW et ava es.print{ <OPTION "3

.. | @D CowsellAServiet

L@ME AtcesstiengSaL if{salectFacultyID == Integer.pdrselnt(is

* é!‘é@ ¢ o3, print ("SELECTED "}: T

Foy, Bk S JavaSotrce )

. 1 B Ebtbraks oo

s 1 & Securty Edtor

L} 58 Web St Navigathn

§ B 23 S0UANMSRL

i 81 & WebContent

-3 was b project

B3 washbwed

= @ peogramming cortest 201 [3 resuts bn 33ms]
= s
EERI
byps Fler bext
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20. Click the node in Java Code Review result pane, will locate to the source with
matching pattern.

$- £ Javssuirce

| ErBi condmsdidemo

i $ @ CorselistServiet.java
] { D corselistsenviet
{

B8 508 avasource
! E Livaries

b |fa Secuy Edior

1 112 WebSte Navigation
i B SQLIANSoripts

| @ weblontert:
533 whasdabprofect
&%) wassbweb

s
|
|
i
H
i
!

T
it

153 ProfieProjpect Sering tren = reg.gatParewever {"horder™):

}g QU-projact . if (vran != mrll)

: :1?:‘; A0-ih.: G 2SLTET - pbrdarSize = -
By Deploymnent Descriptors sqfdematieb] } - %‘:’
=33 Java Resources f};

) DatabasehccessUisrnsaL:

tren = req.getpammeaer("aelectraculbylb"]:
if {cran != npull) {

selectfacultyID = Inveger.paraeTobitran):.
3 i .

rron B ras

o

gtng'nnrﬂ_wni'gﬂ lf'gfa_!_ﬂ,;‘-rr_q-_‘_r_gn‘ﬂqdp'!\_-

2ed
&

programeming contest 2611 [3 resuts n33ms)
¢4 ot A
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fevpe filter text

- General

! - Agent Controller

| - Ant _
¢+ Backward Compatibifity

@& Crystal Reports

- Data Management

E Ecore Diagram

&-Help

- Instalifpdate

i B Java .

U @-JavaEE

i

@&+ Javascript

= IPB

i~ Jython

&~ Modeling

@ Plug-in Development
i3~ Profifing and Logging
g2- Report Deslgn

@ -RunfDebug

G- Server

21. In Window > Preferences, select custom rules and category. click Add Rule...

| -~ Test
P - Yalidation
o @ Web

(5 Web Services
&~ XDoclet

8 & Java Code Review
f-G23 programming contest 2011

= 5‘% Java Code Review
& @ programming contest 2011
“--(& avoid calling java.lang.Integer.parselnt)

Page 22
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22. Select programming contest 2011 as parent category

Choose a parent category
Select the category where the rule wilt be added

& 53 Java Code Review
Eﬁ?ﬂ% Dasign Princlples
#-52 Globalization

E}@ JZEE Best Practices

f3- 52 J25E Best Practices

B2 Junit

i G2

At

EN
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23. Select template as “Avoid catching a specific exception”

Select Template
Selact a template to use For this rule

G Avold caling & method with a specific number of arguments from a class
3 avold calling a speciflc method from a class
2 ing A Spe epting
G2 Avold defiring a specific methed In classes that extend a given class
ol Avaid defining a specific method Ins classes that implement a given interface
1622 Avold extending a specific class
£-G Avold implementing a specfic interface
; -6 Avold instantiating a specific class
el Avoid referencing a specific package
p~6= Avold throwing a specific exception
L) Use a specified copytight comment
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24. Look up 10OException

IOExceptionWrapper —com.ibra. el b2b.util - C:\Program Flas IR SDRruntimestbase_sTiplisinsicom. b, ws. s
10ExceptionWrapper - cosa. b, xml xbxp. apf i - [WebSphere Application Server ¥7.0 JRE]

TegalOperationException - cora.ibreeis.utl.cache - CitProgram Files\IBMSDPYruntimestbase v pluginsicom.dbrr
1IlegatOperatidnException - corn,fom, websphere csl - C\Program Files\IBMIEDP runtinesibass 7 ipiudinsiconm.ib

o
]
it
T
1 & ImagingOpException ‘
@
T
@
@

e

i

InvalidobjectException - cor. ibm.mes, naming. utd - CiProgram Files‘i,IEM'\SD‘P\,rmtin'ses‘l,basr:_v?’;pl'ugins‘x,cqm.ibm.
IrevalidObjectException - javs.is - [webSphere Applicatior Sesver v7.0 IRE] ‘
InvalidOperationException

InvalldOptionException

R E L AT R
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25, Change the severity to “Warning”

Assign Template Values

Fill in the values associated with this template

IOExcent

on

java.io

Software Analyzer using I3M Rational Application Developer
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26. Another rule created.

[type‘filter text

- General
& Agent Controller
{3 ant

- Crystal Reports
@- Data Management
EE -Ecore Diagram
&-Help

- InstalfUpdate

@ Java

8- JavaEE

[ﬁ - Javagcript

S

i+ Jython

@ Modeling .
- Plug-in Development
f&- Profiling and Logging
-Report Design

&:} -Runfbebug

- Server
.- Service Policies

-- 5IP

L~ Yalidation

& Web

5 Web Services
[ ¥Doclet

i Backward Compatibility

= Java Code Review
-5 programming contest 2011

 Defete Ca

SRk GUstom B

& 5 lavaCode Ré\vlew
B2 programming contest 2011
i inglinva. fang £

fivold catching exception java.io JOException
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27. Config the Software Analyzer Configuration.

( in ersaUstSavret java 52

I com, ibm. 95, ££dc. impl. FfdoProvider logEngf,
FfdcProvider I com,ibm.vs,ffdc.impl,FfdeProvider 1oglnd‘

) chten |AULXEEPLIOR X&) \ ED
TR System, out.printin("IOException:™ + ie.cnszriu‘j""
2 12 Pr <how I aksshifew b § ) catch [Exception e){

@%Qﬁ-ﬂ Syatem, out.printin("Exception:” + e.toString(.

'-?Lsg - {5 Copy ahc }

% .

e k%cwwbdm

PR % Paste CohY

o 5-3‘-; 3t Dekete Dekte hlio void doNenu{HttpServletRequest red, HctpSe:vle
i s Pusd Pt y Fovs ServietException, IOException .

LR Refacter RASHIET ¥ by pra of dokenu

S

L R

t 73

; 1 Qa:q@ Refresh F5

il il ko Close Profect
. gg Close Lewelated Projects gl . Y
a L w #m 055291764 CSTH DODDDDDD BSC.’nanne.ti'ram J\

Bt w ! _105:20:764 CST} 00800400 ¥5ChannelFrem A CKFEQDEI:
AHI : XL BChannelFram A CHEU0O1SI:
ChannelFrem A CHFE00191:
Rmnjmt EChannelFram k.  CHFEQO19I:
Customize/Bind SGLY Profies... 1 hiked s e Cha_m_\a.\‘r:am A CHEWED191:
Run As » 1051298796 £ST)] 0000000L SchedulerServ 1 SCHDOOTII:
Debug As » 105:29:796 CST] ODDOGIOE SchedulerSery I SCHDDOTEI:
Srofie A N :05_:29:827 €ST] 0DOODODD RUIConnectorC A ADHCQD26I:
i Source N :05:29:883 C5T} ODDDDDDE! JHZConnectors I ADNCOO5BT:
o N :05330: 108 CST} pefalulutslelsli] UsSe;verImpl A VSVROOO1I:
Team, 1051361624 CST] 0000000¢ Hodelfgr I ¥svRoBDils
Compare Wih ¥ .05139:874 CST} 0O0N000c Vork3paceWana A . VESPDSOQI:
Reslore from Locel Hstory.. 106:09:358 CST] 00BODO1d FidcProvides
Web Daveloprment Todks : ;051091350 00000014
PDE Tools ’
JavaEE '
Servies L
24 Took ¥
Source 4
Proparties AntEnter ]

Transpn:c
The Trapsport Chanhal Servis
The Transport Channel Servi
The Transport Channel Servi
The Transport Chamnel Servi
The Trendport Chdingl Servi
The Schedulér Servics ‘is skf;
The Scheduler Seivice bas ci:
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28. Goto the node programming contest 2011.

Ereate, manage, and run configurations

Select arange of inputs from the scope tab and &t least one rule from the ndes tab to create an analysis configuration,

= 5 Software Finztyzer

{53 pisgraairing Contest

& 16 hanip I0/1)

& E1e8 Peformanca [5/39)
B

&

F162 private API{0{3)

(@D programming tontest 2011 [172)
i‘{ﬂ (S Avoid caling java.lang.Integer.parselnt(}
1171 [ awold catching exciption fava.io.JOException

P2 Security (026

{a

Fiter matched 2 of 2 kems
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29. Check the “Avoid Catching exception java.io.JOException” and Apply.

Create, manage, and run configurations
Select arange of inputs from Ehe scope tab and ot Isast ons rule from the rues tab to create an analysis configuration,

-1 Noving [041]

g1 62 perfomance [0739)

& {:]d;l Privete AP1[0/3) ) ) .

&! programiing contest 2011 {2£2] o ,
- 7] 2 Avold caling java.lang.Integer.parselnt) S

} L[] 18 Avoid cakching exception }ava.b.lOExteptbn

Eri’ihé Securky [0f26}

Fiter matched 2 of 2 tems

Page 30 Software Analyzer using IBM Rational Application Developer



30. Run the analyzer again, and you can see more results.

} oaten ARFEEEPTA0N, 1Ef i
System, out.printin{”I0Excepvion:t” + ie.toﬁ:ri*‘?
} catch {Exception e}{
Sygcem, ozt printinftException:” + e. r.nS\:rlng(

}

#a B Depbvrm Desaiptor: s@emwavb

8—25 Jarva Resources

L B 83 JaveSource

. . B B onbrsdidens

Lt & JI] Cowrsetitserdst Java

v '@ O Cowselistserviet
- i} DatabsseAtcessUsingsQl

2 5B S0 1lavaSource

i )k thradkes

i-da Security Edkor

-- F[§ web Ste Navigation

R U

}

puhiio void doMenu(HotpServletRequest red, Hl:l:yServle
throws ServievException, IOException
{

b S ds; DataSrte
‘9* )
- B dol{HitpservistReqes |
Lo &Mtﬂtpﬁavﬁkm%g

} /4 End of dofenu

& §5 SQUIARSits
® (3 WebContent

] e ot 0 e et e S 0 £

; @ B3 was b projedt
2—52%5 WS dyweb

1

H

T e

o

-BF Pfogmm'hg Cmtestznu (u:olrm 5]

& @ i\wid caling }ava.lam Irtew parsei.nto [E] rem’ts n :ms} .
E— & CoursellstServiet Java:144 Avold cafing Javalang Irteger parselnto'
0 CoursetistServiet.java; 151 Avald caling favads. Irteger.parselnt(}

a- [‘g.wd catching exception Java o OExepton [2reaks N 3Tms]

*L. 55 CoursalistServiel Java:227 Aveid cefing java Jang Inkeger pleselnd) - '

B CoursetistServiet.fava:269 Aveid catching exceqtion java. b,lo-Exceptm
1 CourselstServict, ;m 291 Aveid tatching exception java.bo IGException

T T T AT T oA R

--End of Lab---
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Chapter 6b: Debug usmg IBM Rational Application
Developer

Start IBM Rational Application Developer (RAD) to develop J2EE application which
will be used during the programming contest. RAD is a GUI integrated development
environment (IDE) which is used to perform J2EE and web programming, The resultant
programs will be published to WebSphere Application Server so that it can be executed
in the web environment. '

1. Double clicked the icon "IBM Rational Appllcatlon Developer” on Desktop to
start.

Jamﬁas‘y zg, 26% 'i
{Saturday)

@Eﬁ&m&,@&ﬁ?f

Rational EILCU]
A sottors
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2. Banner will appear and a “Workspace Launcher’ window will appear which

allows you to choose the base location of the workspace, type:
«C\Documents and Settings\swg\IBM\rationalsdp\workspace” as workspace.

Select a workspace
Rational® Application Developer™ for WwehSphere@® Software stores your projacts in a folder called a workspace.
Choose a workspace Folder ko use For this session,
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3. Open the source CourseListServlet.java, Double click the blue left bar at line 172
to create breakpoint

if (bran '= pull)

PRI

H

seleatFacultpIh = Inteper.parselnt{tzan);
3
tras = req.getParameter {"seloceCavrsatoie)y
. it {tran = noll £ tran.tompareTOEr"} iw O}
. "‘Lqﬁi"gon;,;\;&' = new Sreing(rranyz
13

#*% IR &F HTIT PETARETER GEIEAING %4/
FT% STRET IF COGRSZ LIAT =%

3 8 bhraies .
os.printin(m<Blr Optional Courzes </EHL-T)2

oF.peEntini{*<TLELE WILTH=4"500\" BORLIA=Y¥* 4 Stricg.valwedf(borderSite) + "7
oz prinvlind® <TR*"}3

es.printin(® <TErCourse Coded/T>T)r
os.printint” <TE>Title</TEr") 3
os.peintlint” TR (ifering Fesultyd/TEr")
os.princin{* < TH>Yalv</ TH") ¢

os.pelocinl® I TRETiE

ok markers AU o . E CATTE 0
e b ko CouoestSaryit [oes 172] - st Conssellt P HipSerifioquen, kizasendt Servit JEes )

+ Debuy Curreck Dnebrystion Pokkar . - 1 s 5
os.printlng” ZTR>"}§ l %: 3
oa.priotinl® <Tb>* + iString} courseList,gec(i) + P</TD>%); .=
oz.princin(® Tt + (Stcingh courselise.gevfl + 13 4+ "</Tr")s .
os.printin(” <Ti>7 + {String) sovroelisc.garv(l + 2} + he7h 204 3 b

os. p:snlng"A <Tie* 4 {String) coucsebist.getii & 31 + "</TD>%)2
*om.printla(®.  </TRM); . s .

R AR L

1ERUGi161t Tool informaticn la helng 3nw=d fn file
Files) IBMS0PYruntinasibase 1 vriprof bes\vasToprofilet) lws\:emrl\ecut&wﬂr.lw

AbRUDIZEX: Starcing test vich The wasHprofilel profile

AbEUI100T: Resding contiguravion for sscvars scoverf

ADADI200Ts Server Jausched, Waiting for inmitialicavfen stetus.

(ADNTIO00I: Server s&pvari ppen for a-husintssr precess id 1 2252

Page 3 Debug using IBM Rational Application Developer



4, Right click the CourseListServlet java file node, click Debug As > Debug on
Server.

Conpection con = ds.getlonnectioni)?

i
¢
g

int bordersizs = 0

t

ez STARY OF YSEP VARTMSLES WEFINITIOH ##f

o der DoeSorts

N B
AMQ;SH\EMER,H-
a doPoshlFdipServistRaquest,

vi_.n_ths‘ilectfa:ulwm LSV
3 lelactCoursecode = new String{"COURSE COLE=} S

g
5

[

T4 OF USER VARTALLES DEFIRITIG **/ L ®
AW b é“‘as.
£3 ran = Téq.petPareneter |ordecT) 5 ;
3} 4= nuii} { -
¢ ocm—eesree = Ligiss = Integer. parsodnt[tran)?

HY It &F HTTP PAPARETER JRLEBING 4%/

g getPararater ["selectlacultylnty;
t= nukl)
-cFaculryld = Integer.parseZat{tXen)$

eSS F

AT ¥
=q.gewanm=ter&'a-l:ctton:se(oﬂe'):
t= putl £§ tren.compareTo{""} 1= O}t
o trea—e— e — - --ptCourzelode = new Brringitean})

F HTTP PARMETER GRIBSTNG *Hf

b b sotrer LsT l

Sacorp From Local FERLONY 0
Trstrumart 2500 SR el
Java EETooks
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5. Choose WebSphere Application Server v7.0 at localhost as the server.

Déhug Gn Server

Seleck which server Lo use
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6. Include QO-project in the Project to debug

Add and Remove Projects £2 K [
Modify the projects that are configured on the server oy 'l

@ (& WASab-project @ (B Qu-project
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7. 1t may switch to Debug perspective, click Yes.

Page 7 Debug using IBM Rational Application Developer



8. Prompt the debug perspective, and locate to the breakpoint just defined on line
172. And in Variables View, you may found the node selectCourseCode

By

i

Vo Hiierg St e ahpotk | - ; - el Cou selis s ‘_6. :.=g_'-7”-.--'_g;-,, 3 R

DL Coneletaierdtta s e hi, HGSH TR e, St os E 6 e TStietRemonse {d=1661)

[ ConrplitSeniet doServicefHhipSandetiegmst, HipSendatRaqonse) Iont: 19 - Buferedserettulpt Rreamn (d=1500)
- Cera selistSonviat. & z st, HtpServ Y ina: 50 ® & wn .
‘l ; . < ratiy ok} service{HitpServk xst, HitpServietiespocse) ie: 718 & boedersas

[ £ B, Aet}serdeelServ ¥, Serdek {9 ine: B3L i

Ll : HStrstirapper) ser L + Corvietf nippSendetimorstin, |3 6 iddG

Pi e Asacviewrappert hardk Ser ppDspaide o cart

Pl appet 1 {send 1, ServetResporse) o 459 ] u hachods

HEH. BeRuaqmst{sente A sy et 175 - ] o offest

EETEA . (et 5o Y3t M

s :gw&c“w' ook aiperhand: Recnsk ) It €50 ES o

P WoWebContaner handiePeqest{iRequest, IRerpansel ket 1566 s e e bt el T e e
{5 ;S WthimslikosdtviaCorneton) et 175 CERERES

ol S MiotnboudirkhandeDioimnation i £55 gy T

R0 -cas;
as,princln{ <TH>Title</ TH") 5
os.prinyhal® <TRxOLfaring Fatuley</TH»")7
os.printini” <TH>Unit</TH>®) 2

os.arinuni" <fTR3™1 )
T T R R TR R R T R RS, PO P e L L

AT T
:nt(mbl i=0r i< couesebiat.size{ds 1 += 91
os,priatlni® <TRI"})

oa.printin(” <Tov" + {5erfng} courstlist.gev{i)} + TR

ba,prantlof® - <TI* & {String) eourselist.get{i + 1) + "</TD>"13
os. printini” T <Tpe™ 4 (String) courselist.gev(i + 2} 4 "ITER"S
u:.;untlm" <TD»® ¢ [String} ecburselist.getii + 3 + ST

es.priaving™ </ TR>"}z ..
1

os.p:;utln("q'uat.b'); .

phes erver v}, 0 5etver.
Tool inforration is being logged in £ile Cr\PL

ogran

[ApHURI161s

. Filzs\IEK\SDF\runt!:es\buse_v'i\p:ot!les\Ias?Dptatﬂ.el\lous\!:n‘el‘l\sba:tsexvet.loq
IapEDO12BY1 Starcing tool with the vartprofiled profile

AMHD3100T: Pemding configuration for servar: seryarl

ALHUZ2001: Sarver lsunthed, Paiving Yoz imicialfzatlon scatus,

ALEUICOOI: Server serverl opeh for e-husinezss PIocess id is 2252
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9. click the value of selectCourseCods, edit it to “ENGO0104", leave the box to save. Click
resume.

S

EE,
CourselbtSanviet, (d=2418)
SRISendetRequest {d=10%5)
ST5ervietiesporss d-168)
BfferedSerdatuipifress (d=1500)
WX esoUCerraction. {U=1325)

EEA

b

1% [tran (= Auld} {
select¥acultylh = Inteper,parseIntitran}j

]

tran = rag.getParewater{~selecrCoursefods®}y

3£ {tram != null &€ tren.cempareTo(®7) I= O}
=electCoursetods = new String{tren)s

} .

Fer EWEL OF BITP FARKEETZR SRABBIND rtf

#27 STRRT OF $QURRE LIST +9/

&s.princingmsils Optional Courses </EI>");

as.p_:ln:].m"’c?l&b‘t 'wb:m:-i"sob'\" “z‘mm-\;— ;_s:nnq. vi;ueD‘I‘rbo:derShe)_# LA T
os,printin{” <YR=®}5- :

os.peintin(® <TE>Courze code</TH>"}2
os.printin(® <TE>YLC1e</TH»") 3

ALARG156T: Tonl information iz being logged in Zile Ci\Progrem
rues\IB!\SDP\tununga\bue_v’?\p:oﬂles’\-as'ropzo:ilel\logs\sewnx\uturjewe:.log
ADFEU012812 Stsceing ool with the was70profflel profile
ALET3100T: Pendity configuration for seryars serverl
APEUI260T1 Server launched, Waiting for initfalizamtion stotus,
ADED3IODOL! Sexver serverl opan for e-pusinessy process id i3 2252
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10. Return to the browser, you may found the value of edit box changed to
“BENG0104”. Which the value has been updated in debug. I :

g_gci Viw | Hstery - Hookarks. _ :
Lo ARit) : i T R ]

100 Lorse Selech

Optional Cowrses I
Cowrse Code Title Offering Faculty  Unit
ENGO104 Engineering mathematics Engineering 3 : ' _

[Encoiod |{sotect]

fOfiering Faculy 32 |_lter

éha@tdeu

List of Faculty

--end of lab--
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Multiple Cholce Input Process

= Login Screen
- User Login / Password

» Afier login, it will show your team
name and your login name with the
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Chapter 7: Multiple Choice Screen Walkthrough

Objectives
In this exercise, we will learn:
¢ How to connect to the multiple choice screen

¢ How tologin

s How to answer each multiple choice question

o How to submit your answer once you are finished

e How to examine your submission status
Exercises

1. Inthe VM that is started in Chapter 1, open an Internet Explorer and type the URL
http://cogserver/tmlweb

You will see the login page like this,

Log In
i ijea-;eedcamkformaﬁon .

WY/ rome {@?ﬁﬁ %

l) m:j‘] vl eug; Y &b‘» Y 0’9\

Pleasa note that after sometlmanfmﬂvly, o
ynuto;!g-magah'l .

e

L&
|2

Lkmedm&rhh ofim&fp L
Wl&ﬂ@mﬁ&maﬂlb&mm

lmmlm&m TH1 and Sogros are trademarks of
B Corp., ﬁ?ﬂﬂ&dhm&nyj.mﬁzﬁmswoﬁw& i

2. In the Log In screen, just leave the Admin Host blank, and select “planning sample”
in the TM1 Server.

Next, Login into the multiple choice application by the supplied credentials. Afier
you had logged in, you can check if the team name and user name is correct.



£y{1Base]

Plzase clicieiext or on ffre bottom: fab fo go fo sach quel
Answer

3] Fiakse Provide your question here

Ans i
Ang 2
Ans 3
Ans 4

Ans 8 —1

Team Name User Name

moooe

Cognos.
Ssoftware
EEEE

3. After logged in, the first question is displayed and selects the correct answer in the
drop down box, - Click Next for the next question

Team 1 . - User Me_::‘

. OneChai
{Prease click Next or on the botlom fab fe g0 o each quesfion
al Plaaso Provids your quesifon here ' A
A Ans 1 /7
B Ans 2 .
¢ Ans 3 Select your answer in
(3] Ans 4 + .
£ Ans 5 this drov down hox E—
Cognos.
soitware — [
Rl Sy T e TR i =
arfcz|Ga[H|es[oser sl oo Gintmary] o HE

4. To navigate to different questions directly, you may access it through the bottom tab.




User Hme:

OneChal
Please click Next or on the botlom fab fo go lo each question
(&} ] Pleass Provito your quesfion here Mext :
A s " =
0 in""fé Click Next for the'next Question :
D Ans 4 : '
€ Ans 5 —1
Click Summary page to submit
Question navigation bar
Cognos. ) Summary
software s
e e R e e e
015210708 | €5 195 |97 |28 | 0o ] QIt [Smiary

5. In order to submit your answer, you must go to the summary page and review your
answer. For your convenience, you may also answer the question in this summary
page directly from each of the drop down box besides the question number. Note that
your Status now should be “Not Submitted”, After you confirm it, press the button
“Submit”.

Team 1 User Name:  OneChai Status.

Mot Subngitted

You can change your answer hero. Plouse ofick on the submit bullen fo submif your answer, Nofe that you ¢an only submit on

Prey
Alternatively, | & o N
sl i - Submission Status. -

you can input J &

your answer | « |
here [ @ ; : e
" Press Submit button when
you are done \ .
Cognos. e
software

N L e A T L | R O N



6. Once you submitted, a confirmation box should be appeared. Also check the status
should be changed to “Submitted”. If you got an error message, please contact your

judge.

DdnGL S
Team 1 User Hame;  OneChai SBfalya:  Submjtted
You gan change your ansser here. Pleasa elick on the submit bullen lo submil your answer. Note that you ¢an oaly submit $ce.
Sunal
/ Pret

Status get
updated

[+

a3

Gognas.
soitware

|51 )iz} o | o6 67 | i o | ko | iy | @5l

7. If you try to resubmit your answer, you will get an error message like this.




Team 1 Uer Name OnaChai . Btatus:  Submilied
You can change your answer here. Please click on the submil bulton fo submit your answer, Nofe that you can only submif ence.

CO nos.

sottware .

[5G4 S O 165 {0 G510 i | . ] ] o T
If you submit again, you will get
error message

8. Once you have submitted your answer, the score will be appeared in the Score
Dashboard after a refresh.

o 2

Current Leader: HKU Team 9, UST Teant 3

Coagros.
software
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